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What's New?

In the user manual, the icon has been added on the left margin to highlight
information on new and updated features.

The sections updated to reflect the new and modified features on Xedio Manager from
Xedio Suite 4.40 (compared to Xedio Suite 4.35) are listed below.

Active Directory Integration

The Xedio workstation may be integrated into an Active Directory domain.

» See section "Opening Xedio Manager" on page 1.

» Seesection "List of <GENERAL> Parameters" on page 73.

» See section "Introduction" on page 130: the Origin Manager does not exist anymore.
» Seesection "User Role Manager" on page 130.

+ See section "User Manager" on page 132.

Media Server

Some enhancements have been brought to the creation process of a media server:
possibility to use the hostname of a server or its IP address, possibility to use existing
directories or to make Xedio Manager create them, possibility to use a SAN direct access.

» See section "Creating a Media Server" on page 32.

Updated list of CleanEdit Software Parameters

A new parameter is available to allow the use the new Blur effect from CleanEdit.
A new parameter is available to allow the import of subtitle files.

» See section "List of Parameters for Xedio CleanEdit" on page 79.

What's New?

Vi
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1.

1.1.

1.2.

Introduction

Product Description

An installation of Xedio Suite can include a single workstation providing a single fast and
easy editing facility or a range of workstations running the various applications included in
the suite to provide a complete newsroom or sports centre video production solution.

Each installation of a Xedio Suite requires its own specific configuration and set of
parameters. All the workstations, the users, their associated projects, and the whole
media pool are available to the system. Each of these is referenced within the Xedio
database.

Xedio Manager is the application within the suite that manages the configuration of the
installation and defines the parameters used by the system.

Xedio Manager is designed for system administrators to easily use and set the system up
from the very beginning of the installation to the daily asset and content management.

Xedio Manager can be installed on all computers connected to the Xedio network. The
only requirement is an ODBC connection to the database; otherwise there are no specific
computer or network requirements necessary to enable use.

Opening Xedio Manager

To start the Xedio Manager application, select the application from Start > Programs >
EVS Broadcast Equipment or click on the Xedio Manager icon on the desktop:

The Xedio workstation may be integrated into an Active Directory domain.

The user group the user belongs to in the Windows domain must be linked to a user role in
Xedio Manager. This determines the set of user rights and user settings the user will have
in the application. In case a user belongs to several Windows groups, the system retrieve
them in alphabetical order and checks whether the first group matches a user role. The
use of Windows authentication must have been enabled in Xedio Manager.

In this case, the login screen opens and users may choose to use the Windows
authentication and connect without additional access codes, or to use the Xedio
authentication and connect with their own Xedio username and password.

In case the auto-log off mode is activated and the Windows authentication by Active
Directory mode is used, the auto-log off becomes an auto-quit function.

If the Xedio workstation is not integrated into an Active Directory domain, a login screen
will display, where users have to enter their own Xedio username and password.

1. Introduction
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2. User Interface

2.1. Overview of the Xedio Manager
Window

lHlustration

The Xedio Manager window contains the areas highlighted on the screenshot below:

Note
The color of some user interface elements may vary with the Xedio skin

installed.

2. User Interface
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2.2

2.2.1.

2.2.2.

Area Description

The table below describes the various parts of the Xedio Manager window:

Part Name

Description

1. Menu bar

2. Outlook bar

3. Work area

4. Logbook area

The menu bar gives access to general commands and to
configuration parameters.
See section "Menu Bar" on page 3.

The Outlook bar presents nine tabs corresponding to the areas
managed by Xedio Manager.
See section "The Outlook Bar" on page 5.

The Work area is only active when an item is selected in one
category from the Outlook area. Thus, the window displayed in
the Work area depends on the selected item. Parameters are
set from this area.

See sections "Encoders" on page 7 to "Users" on page 130.

The Logbook area lists the operations that the user performs in
the database and their status. If a problem occurs, an error
message is added in the list. At the same time, the application
saves all this information in a log file.

Menu Bar

Tools Menu

The Tools menu gives access to the Media File Cleaner tool. This tool shows the list of all
the media files present on the Xedio media servers but not referenced in the database
(orphan files). From the Media File Cleaner window, it is possible to delete these orphan
files. See section "Media File Cleaner" on page 135 for more information.

View Menu

The View menu provides the following options:

Menu ltem

Description

Outlook Bar
Logbook Bar

Full Screen

Displays or hides the Outlook bar.
Displays or hides the Logbook bar.
Hides the Menu bar.

2. User Interface
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2.2.3. Help Menu

The Help menu provides the About... option which gives information about the system,
such as version number of the different components.

Ahout ...

Xedio Manager

Copyright [C] E¥S Broadcast Equipment

Additional information :

Application :

Execute Folder :

Xedio Database DLL :

Xedio Database script -

Timecode Extractor :

Database Server Name :

Database Name :

DSN Name :
DBMS :

Libraries :

Database server cumrent time :

The window gives the following information:

Information Item

Meaning

Application
Execute Folder

Pluglins

Xedio Database DLL

Xedio Database
Script

Timecode Extractor
Database Server

Name

Database Name

Version number of Xedio Manager.
Folder Path where Xedio Manager is installed.

List of the installed plug-in. When the user selects a plug in
name from the list, the corresponding version is displayed next
to the field.

Version number of the DLL allowing the access to the Xedio
database.

Version number of the database.
It must be compatible with the CleanEdit Database DLL
version number.

Version number of the application which checks the media and
the timecode inside the media.

Name of the server where the database resides.

Name of the database in SQL server.

2. User Interface
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Information Item Meaning

DSN Name Data Source Name, label of the currently used ODBC link.

DBMS Database Management System type and version.

Libraries List of the existing DLL libraries. When the user selects a
library name from the list, the corresponding version is
displayed next to the field.

Database Server Date and time from the Database server.

Current Time

2.3. The Outlook Bar

The Outlook bar presents nine tabs. They correspond to the areas managed by Xedio
Manager.

Outlook Bar
Encoders
Lir
b achines

tedia

Flayouts

Softwares

Toalz

Uszers

When Xedio Manager is started for the first time, only the Media and Users tabs are
shown. You need to create a media server before being able to see all the tabs. See
section "Media Servers" on page 32.

The following table briefly describes the various categories:

Subject Purpose

Encoders Manages (create, delete and modify) encoders and sets up their
parameters.

LinX Manages interactions with EVS video servers.

Machines Manages interactions with external devices such as VTR, archive servers,
XFile and EVS servers.

2. User Interface 5
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Subject Purpose

Medias Manages all media and associated storage structure as referenced in the
database.

Metadata Manages the creation of metadata profiles which could be associated to
media.

Playouts | Manages the playout servers used by the Xedio Suite.

Softwares | Sets up all software parameters and allows the creation of parameter

profiles.
Tools Manages database content and users jobs.
Users Manages users and access rights.

Each category provides access to a series of items. Once a category tab is selected, its
specific items are shown as icons. Select any of these icons to display its relevant
interface in the Work area.

Refer to the different chapters of the present manual for complete information on each
category managed by Xedio Manager.

6 2. User Interface
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3.

3.1.

Encoders

Introduction

Encoders are physical devices which allow the digitization of incoming audio/video feeds
into multiple file formats. Most of the models are configured to encode lo-res or hi-res feed.
They can be logically grouped to associate physical encoders handling the same feed,
either in hi-res orin lo-res. So, editing operations can be quickly performed on lo-res media
and then reflected to the corresponding hi-res media for further news production and
playout.

The XEDIO 1I/0O encoder model is able to encode both lo-res and hi-res at the same time.

Five items are available in the Encoders category. They are detailed in the table below.

Encoders

Y

Phwzizal b anager

Logical b anager

Freview

Item Description

Physical Manager @ Defines hardware setup and encoding parameters for each
physical encoder.

Logical Manager Defines the logical encoders, i.e. the combination of physical
encoders to form a single logical encoder. For example, a hi-res
encoder and a lo-res encoder receiving the same feed can be
controlled as one single logical encoder.

3. Encoders
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3.2.

3.2.1.

Item

Description

Group Manager

Scheduler

Preview

Allows to create groups of logical encoders that make logical
channels visible from specific workstations.

Displays blocks corresponding to the scheduled ingest already
planned for encoding.

Displays the current video input when the encoder is recording
media.

Physical Manager

Introduction

You must define and configure a physical encoder before you can use it.

When you click the Physical Manager button, the Physical Encoders Manager window is
displayed in the Work area, allowing you to define or update encoding hardware connected
to the network (Encoder type, IP address) and the encoding parameters.

Contextual menus are available for additional operations.

- “*% CDMHIRES
=7 Channel 1

- “% CDMLORES

e
- Channel 1

A-MPEGT Encoder
Compaty : i ast Equiprient
MHumber OF Channels :

Type: MPEGT

oder 1

.00 . 104

3. Encoders
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3.2.2.

3.2.3.

Creating Physical Encoder

To create and configure a physical encoder, complete the following fields and then click
on the Create button.

The encoder name is added to the list on the left side of the window and "Channel 1"
appears underneath. As the XEDIO I/O model is a multichannel encoder, up to 2 channel
numbers are displayed under the encoder name.

Field Description

Encoder Model Select an encoder model among CDM[1] (also called CDM-
MPEG), CDM[2], XEDIO 1/O (also called CDM[3] PCX3)

Encoder Automatically filled at encoder model selection.

Description

Company Automatically filled at encoder model selection.

Number of Automatically filled at encoder model selection.

Channels

Type Automatically filled at encoder model selection.

Label Name you give to the physical encoder, as it will appear in the list.

Preferably choose a name relevant to the job of the encoder or to
its position in the Xedio architecture.

IP Address IP address of the physical encoder.

Description Optional text to describe the encoder. This will appear in a Tool Tip
when placing the pointer over the corresponding encoder name in
the list on the left.

Setting up the Encoding Parameters

Introduction

Select a channel ("Channel 1", or "Channel 2" with CDM[3] PCX3) to set the encoding
parameters.

The encoding parameters fields displayed on the right depend on the encoder model.

3. Encoders
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CDM-MPEG Encoding Parameters

' Charinel 1

mpeg]

Bitrate ft [nput Right Input

nput 1 ~  Analog Input 2 -

Update

The available parameters for CDM[1], also called CDM-MPEG, are the following:

Setting

Description

Media Server
Gop Size
Number of B
Frames

Video Size

Video Standard
Format

Video Bitrate

TC Config

Media storage server where the encoded media files will be
stored.

Number of frames between two | pictures (normal setting is 12).
Defines the MPEG file structure to use.

Number of B frames between two P frames (typically 2). Defines
the Gop structure to use.

Width of the picture. Select a value in the list (typically 352 for the
lo-res and 720 for the hi-res, fora CDM-MPEG2).

Choose PAL or NTSC standard.
MPEG1

Video encoding bitrate, entered as a bit/sec number. For example,
8Mb/s is entered as 8000000.

Defines the timecode inserted in the encoded file:

+ vitc: the timecode is based on the video source signal. Select
vitc for all encoders in alo-res + hi-res configuration.

* local time: the timecode is taken from the CDM encoder local
time.

» encoder config: the timecode is managed by the encoder
itself (from the CDM Manager application).

10
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Setting

Description

Audio Numbers

Video Ratio

Number of audio channels to encode and multiplex.
This is related to the audio configuration table that defines the
audio parameters for the encoded file.

Selection between 16/9 and 4/3 formats for encoding.

When you have done the required modifications, click on the Update button to send the
new parameters values to the encoder hardware.

CDM[2] and CDM[3] Encoding Parameters

Overview

Audio Groups

Giroup 1 Giroup 2 Gioup 3 Gioup 4

Right Input

AHIRES_D.jpg

The available parameters for CDM[2] and CDM[3] are the following:

Setting Description

Profile Encoding profile used by the encoder.
The profiles come from a list of xml files stored on the storage
server (in the Profiles/CDM2 folder). These files define the
codecs/formats and their parameters.

Storage The storage server that stores the encoded media files.

Audio Groups

This parameter is only available for CDM[2].
Only two groups of embedded audio can be selected
simultaneously.

3. Encoders
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3.2.4.

3.2.5.

Setting Description

Audio Channels | The audio sources can be chosen using the drop down lists in the
selected groups.

Preview Thumb | Path of the thumbnail, automatically generated by the encoder,
Path during video digitization.
This thumbnail is used in Xedio Ingest Organizer scheduler and
Xedio Manager to preview the source being encoded.

How to Define the Storage Subfolder

To define the subfolder where the files will be stored, proceed as follows:
1. Double-click the Database Reference field in the Storage area.
The Reference Storage window opens.
2. Click the button next to the Subfolder field
The Folder Auto Name window opens.
Select one of the options from the list of available items.
Click Append to add the selected item at the end of the folder string.
Repeat steps 3 and 4 for any new information type you want to add in the string.
Click OK.

The selected string is displayed in the Subfolder field of the Reference Storage
window.

o o M W

7. Select the Transfer mode.
Click OK.

Modifying the Physical Encoder Properties

To modify the properties of a physical encoder, select it in the list, enter new values in the
relevant fields, and click the Update button.

Possible Actions with Contextual Menus

A contextual menu is available when you select an encoder name in the list and then right-
click. The following options can be selected:

Menu Item Description

Duplicate Creates a new physical encoder with the same properties and same
encoding parameters. The term "duplicated" is added next to the new
encoder name.

Delete Deletes the encoder configuration and removes it from the list.

12
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A contextual menu is available when you select a channel in the list and then right-click:

Menu Item Description

Set Label / Opens a dialog box allowing to update the "Channel 1" or "Channel 2"
Description name or to enter a description.

3.3. Logical Manager

3.3.1. Introduction

When you click the Logical Manager button, the Logical Encoders Manager window is
displayed in the Work area, allowing you to logically group physical encoders as being part
of the same channel. Possible configurations use two encoders in hi-res and lo-res or one
encoder in hi-res only. With a XEDIO 1/O encoder model, lo-res and hi-res are recorded by
the same encoder.

Label :

fault = 10:24): 1024

[ empty = no

3. Encoders 13
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3.3.2.

3.3.3.

Creating Logical Encoder

To create and configure a logical encoder, complete the following fields and then click on

the Create button.

The logical encoder name is added to the list on the left side of the window and the name
of its corresponding physical encoders appears underneath.

Field

Description

Label

Logical Encoder
Group

Physical Low
Bitrate Encoder

Physical High
Bitrate Encoder

Xedio Ingest IP
address

Xedio Ingest TCP
Port

Switcher Output

Color

Position

Description

Give a name to the logical encoder.

Select the group you want to link to the logical encoders. This will
determine the Ingest Organizer workstation which will see the
encoders and this is used to restrict the access to some encoders
by the Ingest Organizer.

The GLOBAL group makes the encoders visible to all the Ingest
Organizer workstations.

Select the low bitrate (if applicable) physical encoder to be part of
the logical encoder.

With a XEDIO I/0 encoder model, selecting one of the physical
encoder channels automatically allocates the other channel of the
physical encoder to the corresponding low bitrate or high bitrate
field.

Select the high bitrate physical encoder to be part of the logical
encoder.

IP address of the server hosting the Xedio Ingest Organizer module
controlling the encoder.

Port of the server hosting the Xedio Ingest Organizer module.

Output of the switcher to which the encoder is connected.

Background color of the encoder channel in the Xedio Scheduler.
The color palette is available by clicking the Color button and then
selecting a color from the drop-down list.

Position of the encoder channel in the Xedio Scheduler.

Optional text to describe the logical encoder. This will appearin a
ToolTip when placing the pointer over the corresponding logical
encoder name in the list on the left.

Modifying the Logical Encoder Properties

To modify the properties of a logical encoder, select it in the list, enter new values in the
relevant fields, and click the Update button.

14
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3.3.4. Possible Actions with Contextual Menus

Deleting a Logical Encoder

A contextual menu is available when you select a logical encoder name in the list and then
right-click:

Delete Logizal Encoder

Menu Item Description
Delete Logical Deletes the logical encoder configuration and removes it from
Encoder the list.

Exporting and Importing Encoder Properties

A contextual menu is available when no encoder is selected and you right-click in the
encoder list area.

Menu Item Description

Export Encoders Exports the list and configuration of encoders in a readable file

(.enc format).
In the Save As window, select the folder to export the file to.

Import Encoders Imports the list and configuration of encoders in a readable file.
In the Open window, select the file that contains the encoders

list to import.

3.4. Group Manager

3.4.1. Introduction

When you click the Group Manager button, the Logical Encoder Group Manager window
is displayed in the Work area, allowing you to group together multiple logical encoders.

A group of encoders will then be visible only to a predefined Xedio Ingest Organizer
workstation. Indeed, at first run of Xedio Ingest Organizer, the group membership is set.

3. Encoders 15
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3.4.2.

Label : aroup 1

Dezcription

Creating a Group of Logical Channels

To create a group of logical encoders, complete the following fields and then click on the
Create button.

The group name is added to the list on the left side of the window.

Field Description
Label Give a name to the group of logical encoder.
Description Optional text to describe the group of logical encoders.
Logical Encoders Select the logical encoders to group together.

Note

A group of logical channels restricts the amount of available channels for
specific Xedio Ingest Organizer workstations. There is one default group, called
GLOBAL, that allows a Xedio Ingest Organizer workstation to “see” all
channels when it is selected.

Note

Tofinalize encoders configuration, it is necessary to store the CDM encoders
mapped drive in the database. See section "Setting the CDM Encoder Mapped
Drive" on page 37.
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3.4.3.

3.5.

Deleting a Group of Encoders

To be able to delete a group of encoders, you first need to clear the logical encoders boxes
and click the Update button.

Then, right-clicking the group name will show you a contextual menu with the Delete
option.

Scheduler

When you click the Scheduler button, the Scheduler window displays blocks
corresponding to the scheduled ingests already planned for encoding by all the logical
encoders.

gl

220/ 2009 15:04:16 - 274 0/2003 12:0...

As this function is the same as the one available in Xedio Ingest Organizer, please refer to
the user manual of this application for more details.

Preview

When you click the Preview button, the Preview window displays simultaneously the
video currently under processing and encoding at all encoders inputs.

The only available parameter is the Refresh Rate defined in seconds.

Refresh Rate (in sec.) :

3. Encoders
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4.

4.1.

4.2.

LinX and Direct Access

Introduction

Xedio “Add-On” for EVS Video Server is based on LinX protocol and XT Gateway. The
LinX Application Programming Interface is an integrated AP| used to access the EVS
family video servers through Ethernet/IP connection.

Xedio can access EVS video server disks (e.g. XT[2], XS) and use the media stored on
EVS server thanks to XTGateway, provided that they have previously been configured.
Xedio will then be able to see, display, search and access clips and record trains on EVS
video servers. New clips could be created in CleanEdit from EVS video servers.

Two items are available in the LinX category. They are detailed in the table below.

xTE

E%'S Video Server

X

fiden Server Group

Item Description

EVS Video Server Defines setup parameters for an EVS video server which will
be used by CleanEdit to see, display, search and access clips
and record trains.

EVS Video Server Defines the parameters of the web services used to interact
Group between Xedio and the EVS video servers.

All the steps below must be followed.

General Configuration Parameters

The following parameters must be defined from Softwares > Parameter Profiles > General
> General tab:

* Notification Center Address: set the IP address with port 48888.
Example: 172.22.23.9:48888

+ XedioBroker Address: set the IP address with port 8762.
Example: 172.22.23.9:8762

18
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4.3. EVS Video Server

4.3.1. Introduction

All the EVS Video Servers you want to access through LinX protocol must be referenced
in this category.

The Discover button helps you to “discover” automatically all the EVS Video Server
available on your network. If a server does not appear in the discovery, you can try to
restart the server or check the network path between the local machine and your server
(e.g. mutlicast shall be enabled), If it is still not discovered, then configure the server
manually.

When you click the EVS Video Server button, the EVS Video Server Manager window is
displayed in the Work area.

Label Ganging

I R

4.3.2. EVS Server Parameters

To set EVS video server parameters, complete the following fields and then click on the
Save button.

Field/Button Description

Server Name Name of the server to be accessed by Xedio, as you want it to be
displayed in the interface.

Description Optional text to describe the EVS Server.
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Field/Button

Description

FTP Interfaces (HCTX Connections)

IP Address 1

IP Address 2

FTP Login
FTP Password

FTP IP address 1 of the EVS server you want to connect to
(mandatory).

FTP IP address 2 of the EVS server you want to connect to
(optional).

Login ID defined on the EVS server (e.g. evs).

Password defined on the EVS server (e.g. evs).

Control & Management Interface (PC LAN Connection)

IP Address

Connect

Discover

Setup

Configuration
List

Apply
1/0 Channel

PC LAN IP address of the EVS server you want to connect to
(mandatory).

Checks the connection with the selected EVS server.

Opens a window which lists the EVS video servers from the network
and their corresponding PC LAN IP address.

Opens a dialog box which allows to set the AVSP guardbands length
of clips created with LinX (e.g. 5 sec 0 frame).

Conkral Mgt Inkerface - Configuration
Guard Band

Seconds |:|| Frames

YWarning : maximum guard band size is 5 minukes

Send

Displays the list of configurations available from the server.

Applies the selected configuration.

Displays the list of recorder channels from the selected EVS server.

Button Description

Delete ' Deletes the selected EVS server from the tree structure.

Refresh Checks whether the EVS video server is reachable. If yes, the server
configuration is retrieved. If not, the server name and server icon are
displayed in red.

Save Saves the parameters entered for the server.

Clear Clears the parameters entered for the server.
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4.3.3.

4.3.4.

4.4,

How to Gang Recorder Channels

You can gang several recorder channels from an EVS video server. To do so, proceed as
follows:

1. Select several recorder channels in the I/O Channels area.
2. Right-click the list.
3. Select Gang.

The ganged channels are mentioned in the Ganging column.

Possible Actions with Contextual Menus

A right-click on a server displays a contextual menu with the following option:

Menu Item Description

Delete XT Deletes the selected EVS server from the tree structure.

EVS Video Server Group

When you click the EVS Video Server Group button, the EVS Video Server Group
Manager window is displayed in the Work area.

Linzadapter :
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To set a group of EVS video server, complete the following fields, select the servers you
want to group and then click on the Create button.

Field Description

Label Name you want to give to the group of servers.

Description Optional text to describe the group of EVS Servers.

LinxAdapter IP address of the machine hosting the LinxAdapter software, used to
manage the Linx notifications from the EVS video server to Xedio.
Keep 80 for TCP Port and keep the soap string unchanged.

LinxAdapter Not used. Keep 0.0.0.0.

Backup

LinxOutAdapter

EVS video
servers

IP address of the machine hosting the LinxOutAdapter software,
used to manage the Linx commands sent from Xedio to the EVS
video server. Keep 80 for TCP Port and keep the soap string
unchanged.

List of EVS video servers defined in the EVS Video Server tab.
Select the servers you want to include in the group. All the EVS
servers which must be seen and could be used in CleanEdit must be
assigned to a group.

Mandatory.
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5. Machines

5.1. Introduction

External devices can be connected to the Xedio Suite. Their parameters are configured
from the Machines tab.

Several items are available in the Machines category. They are detailed in the table below.

tachines

TR Manager

Archive Serers

LiF]

IPDirectaor

No?
E
F Y

CUETERTETEDET

Item Description

VTR Manager Defines setup parameters for a controlled VTR.

Switcher Manager @ Defines setup parameters for a switcher connected to the

system.
Archive Servers Defines setup parameters for a server used to archive media.
IPDirector Defines setup parameters to use information coming from

IPDirector API.

Xsquare Manager | Defines setup parameters for an Xsquare used for rendering or
file export.
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5.2. VTR Manager

A VTR can be used as a source of ingest. The VTR video output must be connected to the
encoder video input.

When you click the VTR Manager button, the VTR Manager window is displayed in the
Work area.

COr1

[ empty = no uzed )

To set VTR parameters, complete the following fields and then click on the Save button.

Field Description

ID Number automatically allocated by the system when you save
the VTR configuration.

Label Name you give to the VTR device.

Description Optional text to describe the VTR device.

Xedio Ingest IP address of the server hosting the Xedio Ingest Organizer

Organizer IP module controlling the VTR to be used.

Serial COM Port Port used by the workstation when sending data and transport
control commands to the VTR (in RS-422).

Switcher Input Switcher device to which the video source of the VTR is
connected. Leave this field blank if you do not have any switcher
control device supporting Xedio protocol.
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5.3. Switcher Manager

When you click the Switcher Manager button, the Switcher Manager window is
displayed in the Work area.

Tranzmit Switcher [nfo
hier Config Host [P . 100 107 Maching Mame

Switcher Config Host Part :

nze Timedut [in

Apply

You can indirectly control a switcher through the system. If the Transmit Switcher Info
field is checked, Xedio Ingest Server application transmits the switching information over
the Ethernet network to a dedicated software device before starting any recording. This
device will manage the audio and video routing at the switcher with regard to its brand and
protocol, and send an acknowledgement back to Xedio Ingest Server within a determined
delay in order to start the encoder(s).

To set switcher parameters, complete the following fields and then click on the Apply

button.
Field Description
Transmit Switcher Info Enables/Disables the use of a software device to
control the switcher(s)
Switcher Config Host IP IP address of the software device to access to.
Switcher Config Host Port Port number where to send the switching
information.
Wait For Host Response Delay for the “acknowledge” coming from the
TimeOut (in sec.) device.
Note

When timeout delay is reached, Xedio
Ingest Server aborts the recording
process.
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The protocol used between Xedio Ingest Server and the "switching device" uses the
following commands:

Commands sent from CleanGest Server to the

switching device Description
<ConnectPorts InPort="x" OutPort="y"/> Used before starting a
record
<ReleasePorts InPort="x" OutPort="y"/> Used at the end of a
record.
The answers received from the device must be as follows:
Received from the software L
. Description
device
<ConnectOK/> Possible answers following a “ConnectPorts”
<ConnectFailed/> command.
<ReleaseOK/> Possible answers following a “ReleasePorts”
<ReleaseFailed/> command.
<CmdErn/> Error status

5.4. Archive Server Manager

When an Archive Server is attached to a Xedio installation, it must be referenced in the
database.

When you click the Archives Servers Manager button, the Archive Servers window is
displayed in the Work area.

100, 101
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To set archive server parameters, complete the following fields and then click on the Save

button.

Field

Description

ID

Label
Description
IP Address
Is default

Number automatically allocated by the system when you save the
Archive Server configuration.

Name you give to the Archive Server.
Optional text to describe the Archive Server.
IP address of the archive server.

When selected, the current archive server is used by default.

5.5. IPDirector

It is possible to synchronize the Xedio database with the IPDirector database.

The IPD Gateway is a Windows service used to synchronize database information from
IPDirector to Xedio. It subscribes to IPDirector Notification Server.

The IPDirector Notification Server is an IPDirector APl which is used to notify the
gateway when modifications are done in the IPDirector database.

Warning

When the IPD Gateway has been installed, it must be configured in Xedio
Manager and the IPD nearlines must be configured in the Xedio Media Servers
of Xedio Manager before you start the IPD Gateway services.

When you click the IPDirector button, the IPDirector window is displayed in the Work

area.

IPDirecko

Dramain

IPDirector APT

1P Address

TCP Port (O

IPDr User Logi

Full Resyne
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To set IPDirector parameters, complete the following fields and then click on the Update

button.

Field

Description

IPDirector Gateway

IP Address

TCP Port

Domain User
Domain Password
IPDirector API

IP Address

TCP Port

Login

Password
IPDirector Database
IP Address

IPD DB Name

SQL Server Login
ID

Password

IP address of the machine where the IPDirector gateway is
installed.

IPD gateway TCP port (default is 8080)
"\<Windows Domain User with Admin rights>"

Windows Domain Password for this user

IP address of the machine where the IPD API is installed.
TCP port og the IPD API .
Login for the IPDirector user

Password for the IPDirector user

IP address of the machine where the IPD database is installed.
Name of the server where the IPD database is located.

IPD database username.

IPD database password.

Each time the configuration is modifying, click the Full Resync button to force a full
resynchronization from IPDirector to Xedio. A confirmation dialog box then opens where
users enter the dates interval to be taken into account for the resynchronization.
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5.6.

Xsquare Manager

Overview

Xsquare can be used to receive and send media in file format or for the rendering of files to
an EVS video server.

When you click the Xsquare Manager button, the Xsquare Manager window is displayed
in the Work area.

Asquare Servers Asquare Properties

Lab

DB ID

Delete

The Xsquare Servers area displays the list of Xsquare servers which have been defined
as targets from Xedio Manager.

The Xsquare Properties area shows the properties of a Xsquare server selected from the
Xsquare Servers area.

Xsquare Servers configuration

The discovery of Xsquare targets can be done manually or automatically.

Automatic Procedure

To automatically find the list of Xsquare servers available on the network, proceed as
follows:

1. Click the Discover button.

The Xsquare Servers Discovery window opens and lists the Xsquare servers found.
2. Select one Xsquare server.

Click Add.

The properties of the Xsquare server are displayed on screen.
4. Click Save.

The selected Xsquare server is displayed in the Xsquare Servers area.

5. Machines
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5.7.

Manual Procedure
To select an Xsquare server manually, proceed as follows:
1. Click New.
The default host name 127.0.0.1 is displayed in the Xsquare properties.
2. Set the Xsquare properties by completing the fields.

Field Description

DB ID Number automatically allocated by the system when you save the
Xsquare configuration.

Label Label given to the machine hosting Xsquare (optional).
Host IP address or name of the machine hosting Xsquare.
Description Text to describe the Xsquare (optional).

3. Click Save.

The selected Xsquare server is displayed in the Xsquare Servers area.

Modifying or Deleting an External
Device

To modify the properties of one of the previous external devices, except a switcher, select
it in the list, enter new values in the relevant fields, and click the Update button.

Update

To delete one of the previous external devices, except a switcher, select it in the list, right-
click and select Delete from the contextual menu.

L

Delete
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6.

6.1.

Media

Introduction

From the Media category you can define the media storage tree structure and media
classes, you can import and manage media files.

Five items are available in the Medias category. They are detailed in the table below.

kedia Impaorter

ok
e

RTD kanager

Item

Description

Servers

Class Manager

Media Importer

RTD Manager

Manager

Allows to define the media storage server(s) and to create its sub-
folders (multiple storage servers may be defined).

Allows to define a Class List to categorize the stored media.

Allows to import media files into the storage server and to create a
reference to the files within the database.

Manages the animated transition graphics (RTD's) referenced in
the database.

Manages the media files within the database and the storage
server.

6. Media
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6.2.

6.2.1.

Label

Media Servers

Introduction

A Media Server is the location where all the media used within a Xedio installation will be
stored. Different types of directories can be created on a media server to store the various
types of files.

When you click the Media > Servers button, the Media Servers window is displayed in
the Work area. It lists all the existing media servers and allows you to define a new media
server or modify an existing one.

Main Address Backup Address UncPath Share Hame

B & XSTORE70110 1.1.70.11

HIRES

LOWRES

i YOICEOYER
STILL
AUDID

M PLsT

m CLIPTHUMB
m TAGS

m RTD

i PROFILES
i CACHE

|_
|_
|_
|_
|,
|_
|_
|_
|_
|,
|_
|_
|_
L

I cG

6.2.2.

S
S
s
S
S
S
i MEDIATHUMB Sil i MediaThumbFiles!
s
S
S
S
S
B CUEPOINTTHUME 5
S

W XedioMedia‘HiResFiles\ HiResFiles
AXedioMe owResFiles: LowResFile:
X edioMedia\WoiceOverFiles' YoiceOverkE
StillFiles
AudioFiles
PlstFiles

lipThumbFiles\
agsFiles: TagsFiles
RtdFiles\Low' RtdFiles
Profiles
Cache
CuePointThumbFiles\ CuePointll
JXedioMediat\CGTemplateFiles:

Creating a Media Server

Possible Situations

The Windows directories to use for storage may have been created before the creation
process of a media server. If they have not, Xedio Manager will create them during the
process.

When some applications need a direct access to a SAN, the media server can be set as if
it was on the same machine as the application.
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How to Create a Media Server

The Windows Directories have not yet been Created

To create a media server, proceed as follows:

1. Right-click in the Media Server window and select New Media Server in the
contextual menu. The Storage Server page of the creation wizard opens.

2. Fillinthe Main Address and the Backup Address fields:

Field Description

Main Address IP address or hostname of the main server used for media
storage.

Backup Address IP address or hostname of the backup storage server, when a

redundant network is used.

3. Ifthe Windows directories have not yet been created, do not select the Share names
already configured option and fill in the Login and Password fields:

Field Description

Login Login name defined for the media server in its configuration
parameters.

Password Login password defined for the media server in its configuration
parameters.
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4. Click Next.

The 2nd page, Storage Server - Drive Letters List, displays the drives capacity of the
new media server:

TE tatal

5. Click Next.

The 39 page of the wizard, Storage Server - Folders & Shares List, lists all the
possible types of directories which can be created by Xedio Manager:

Directory Type Drive Folder Name Share Hame
WYO Files Folder :

MLoRes Files Folder :

M HiRes Files Folder :

M 5till Files Folder :

MAudio Files Folder :

M Profiles Folder :

M Pist Files Folder :

M Media Thumb Files Folder :
M Clip Thumb Files Folder :

M CuePoint Thumb Files Fol...

M Tags Files Folder :
M RTD Files Folder :
M CG Templates Folder :

Select the types of directories to be used for the storage
The folder name and share name are automatically filled in.

In the Drive column, select the drive(s) where to create each folder or select the All
Folders on same drive option to automatically create all the selected folders on the
drive selected once.

Click Next.

In the 4th page of the wizard, Storage Server - General Information, enter a name for
the media server in the Label field.

10. Click Finish.
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The tree structure of the media server is displayed.

Label Main Address Backup Address UncPath Share Name
B & XSTORE70110 1.1.70.11

|_ HIRES SiXedioMedia\HiResFiles\ HiResFiles

g
LOWRES S LowResFile
B YOICEOVER S oiceOverFiles\ VoiceOverH
STILL S ! StillFiles
AUDID S AudioFiles
B PLST ] es! PlstFiles
i HEDIATHUME s aThumbFiles\ MediaThumi
fim CLIPTHUMB S ipThumbFiles: ClipThumbE
B TAGS ] iles! TagsFiles

5 RtdFiles

S

5]

S

S

Profiles

RO
fim PROFILES
(] Cache

M CUEPOINTTHUMB:

|,
|_
|_
|,
|_
|,
|,
|_
|,
|_
|_
|,
L

uePointThumbFiles:  CuePaoint

i C& S\ XedioMedia\CGTemplateFiles: Ci

The Windows Directories have Already been Created

To create a media server, proceed as follows:
1.

Right-click in the Media Server window and select New Media Server in the
contextual menu. The Storage Server page of the creation wizard opens.

Fill in the Main Address and the Backup Address fields.
Select the Share names already configured option.
If no SAN direct access is used, do not select the SAN access needed option.

If a SAN direct access is needed, select the SAN access needed option and enter a
letter in the Drive Letter field. Then, the machine requiring a direct access to the
SAN will use this drive letter and see the media server as if it was on the same
machine.

Click Next.

The 2"d page of the wizard, Storage Server - Folders & Shares List, lists all the
possible types of directories.

Select the types of directories to be used for the storage

The folder name is automatically filled in.

In the Share Name column, enter the name of the share to be used.
Click Next.

In the 39 page of the wizard, Storage Server - General Information, enter a name for
the media server in the Label field.

10. Click Finish.

The tree structure of the media server is displayed.

6. Media
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6.2.3. Contextual Menus

A contextual menu is available when you select a media server in the list and then right-

click:

Menu Iltem

Description

New Media Server

Rename Media
Server

Delete Media Server

Modify Media Server
Description

Create Directories

Media File Cleaner

Adds a media server storage: displays the folders present in
the path selected for use as media server.

Allows to update the media server label.

Deletes the media server view in the Media Servers window.

Opens the Media Server Modification window allowing to
update the label or description of the media server.

Used to create directories for the selected media server.
Only available when all the types of directories have not been
created on the selected media server.

Opens the Media File Cleaner window. See section "Media
File Cleaner" on page 135 for more information.

A contextual menu is available when you select a folder in the list and then right-click:

Menu Item

Description

New Media Server

Default "Folder Name
Files" Directory

Delete Media
Directory

Collect Media

Media File Cleaner

Adds a media server storage: displays the folders present in
the path selected for use as media server.

Sets the selected folder as default folder for the type of files
(bitmaps, video files, thumbnails etc...). The foldericon is then
green.

This is only necessary when multiple storage servers are
created in the system. This tells the system to use a specific
storage server for some files and another server for other files.
The Default folders may be changed at any time without losing
previously stored material.

Example: for the HIRES folder, the option is Default
"HiResFiles™" Directory and sets the HIRES folder as default
for the hi-res files.

Removes the media folder from the Media Servers window.

Displays the list of media present in the selected folder.

Opens the Media File Cleaner window. See section "Media
File Cleaner" on page 135 for more information.
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6.2.4.

6.3.

6.3.1.

Setting the CDM Encoder Mapped Drive

The physical encoder is usually configured to store the encoded files on a specific
mapped drive, usually called “G” or “H”. This mapped drive letter also has to be stored in
the database in the CDM Mapping column.

To set or change the encoder mapped drive, proceed as follows:

1. Inthe Medias Servers window, double-click a black cell in the CDM mapping
column.

2. Select the requested CDM mapped drive from the drop-down list.

The encoder mapped drive has been set or changed.

Class Manager

Introduction

The Class Manager tool is used to define and manage the ClassList. Classes categorize
the media and the virtual media. They are mainly used in the database lists from the Xedio
Suite to perform search on media. Media are assigned to classes through the Xedio
applications such as Xedio Ingest Organizer, Xedio Importer, Xedio AutoFile Importer or
Xedio Browse applications.

When you click the Class Manager button, the Media Class Manager window is
displayed in the Work area, allowing you to create new media classes and sub-classes.

6. Media
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6.3.2. Possible Actions with Contextual Menus

A contextual menu is available when no class is selected and you right-click in the Media
Class Manager window.

Menu Item Description

New Root Creates a new class of media.

A contextual menu is available when you select a Class in the list and then right-click:

Menu Item Description

New Root Creates a new class of media.

New Child Creates a new sub-class of media.

Rename Allows to rename the selected class or sub-class.

Modify Opens the Modify Class window allowing to update the label or
description of the selected class or sub-class.

Delete Deletes the selected class or sub-class.

Hidden State Hides/Unhides the selected class or sub-class so users

cannot/can use it.

6.4. Media Importer

6.4.1. Product Description

In the Xedio suite, the Media Importer tool offers a way of acquiring media files for use
within the system. Authorized users may import, into the Xedio database, media that have
already been recorded and are in a file format that can be used by Xedio. P2, XDCAM and
XDCAM EX, music, graphics or existing mpeg and dv files are some examples.

Once the files are imported and set to "Publish", they become available in the Media
Manager.

The Media Importer tool is available as:
* aseparate application: Xedio Importer
* as amodule built in CleanEdit, and available in the Media Importer tab.

» as amodule built in Xedio Manager, and available in the Media category.
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Setup

Label :

shooting date :

Publish : W

pkion

Subfolder :

HIGH BITRATE
File

Media Type :

Ratio :

Skark Impart P

Note
The color of some user interface elements may vary with the Xedio skin

installed.
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6.4.2. Importable Media

When you click the Media Importer button, the Media Importer window is displayed in the
Work area.

Different tabs can be displayed, provided that they have been selected from Xedio
Manager: Softwares > Parameter Profiles.

They are used to set the parameters for the different types of media which can be
imported into the system:

+ XDCAM, XDCAMEX, P2 and CANON tabs: to import media files recorded on Sony
XDCAM and XDCAMEX, Panasonic P2 and CANON cameras

+ Video/Audio/Stills tab: to import media files, images or audio files
» RTD tab: to import video containing transitions

» EVS Server tab: to import media files available on an EVS video server on the same
network as the Xedio suite. In this case, Xedio does not import the file content into the
Xedio storage system, but creates a reference to the server files in the Xedio
database.

Refer to the Xedio Importer user manual for a comprehensive description of the tabs and
fields.

6.5. RTD Manager

6.5.1. Introduction

When you click the RTD Manager button,the RTD Manager window is displayed in the
Work area, allowing you to import or manage the transition sequences. The list displays
the available effects stored in the system.

6.5.2. Possible Actions with Contextual Menus

A contextual menu is available when no RTD is selected and you right-click in the RTD
Manager window.

Menu Item Description

Import Imports a transition effect.
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6.6.

6.6.1.

A contextual menu is available when you select a RTD in the list and then right-click:

Menu Item Description

Import Imports a transition effect.

Preview Allows to preview the selected transition effect.

Edit Opens the Update RTD Label window allowing to update the label
or description of the selected effect.

Delete Deletes the selected effect from the database. It can only be
removed if it is not already used in an edit, otherwise, an error
message will occur.

Video Standard | Allows to select a video standard among PAL SD, NTSC drop SD,
HD 1080i @50, HD 720p @50, HD 1080i @59,94, HD 720p
@59,94, HD 1080p @50, HD 1080p @59,94.

Used by Opens a window to show in which projects the selected media is

usedin:

Media Manager

Introduction

The Media Manager tool is designed to give an overview of the database content, to edit
some media properties and to delete media files from the database and from the storage
server(s). Different search tools can be applied to the database content to help users to

find specific media.

Note

Only items that are not used (not locked) in any user project and not used to
create virtual media and/or clip can be deleted; otherwise, an error message will

occur.

The media items displayed in the Media Manager window are all the media items
corresponding to the filters or search tools applied.

When you click the Media > Manager button, the Media Manager window is displayed in

the Work area.
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ALL Criteria are met
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Undefined

Undefined

Undefined

Undefined

Undefined

Undefined

Undefined

6.6.2.

Athletisme_C00040_14h05 i - : 4-03-2009 14:05:20 14-10-2011 15:5
Athletizme_CO0050_14h05 3 5 ] 4-09-2003 14:05:20 14-10-2011 15:5

Athletizme_CO0060_14h05 4-09-2003 14:05:20 14-10-2011 15:5

Athletisme_C00070_14h05 . : 4092009 14:05:21 14-10-2011 155

Athletisme_C00020_14h05 ; 14092009 14:05:21 14-10-2011 15:5
Athletizme_C00030_14h05 ' i 4-09-2003 14:05:21 14-10-2011 155

Athletizme_C00T00_14h05 4-09-2009 14:05:21 14-10-2011 15:5

The upper part of the Work area gives access to the different filters which can be applied
to the media list.

At least two tabs exist on the left of the Media Manager window.

» The Filter O tab: The element grid displays the list of all media present in the database,
or it returns the result of a search applied to the list.

+ The Today tab: the element grid shown the media with "creation date = today".

Additional tabs are displayed when the users have saved filters applied to the database.
See section "Using Saved Filters" on page 56 for more details.

Media items are displayed in columns.

Elements Grid

Sorting the Elements in the Grid

You can change the sort order of elements in the grid by clicking the column header for the
parameter according to which you want to sort the elements.

The blue arrow indicates the sorting order. Clicking the column header again changes the
sorting order from ascending to descending or vice versa.
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Organizing Columns

Resizing Columns

A column can be resized by using the mouse pointer over columns intersection and
dragging it to the right or to the left.

Selecting Columns to Display
To select the columns to display in the grid, proceed as follows:
1. Right-click the column header area.
A menu is displayed.
2. Select Choose Displayed Columns.

The Select Visible Columns window opens and shows the list of columns in the
current order.

3. Toselect the column(s) you wish to add to the view, do one of the following:
o inthe left pane, double-click the column(s) you wish to add to the view
o select them in the left pane and click the Add button

4. To select the column(s) you wish to remove from the view, do one of the following:
o onthe right pane, double-click the column(s) you wish to remove from the view
o select them on the right pane and click the left arrow

5. Click OK.

Ordering Columns
To change the columns order, proceed in one of the following ways:
1. Select a column header
2. Dragittothe left or right to the required place.
A vertical line shows the place where the column will be dropped.
OR
1. Right-click a column header.
A menu is displayed.
2. Select Choose Displayed Columns.

The Select Visible Columns window opens and shows the list of columns in the
current order.

3. Select the column name(s) from the Selected pane.
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4. Click the appropriate button:
o Up: moves the item(s) before the previous one
o Down: moves the item(s) after the next one

5. Click OK.

Element Contextual Menu

A contextual menu with the following options is available when you right-click an item in
the list. The options may differ according to the element selected.

Published State

Allows the selection of a sub-menu to change the publish state of the media between
Published and Not Published. A published media will be displayed in the database lists
of all the software and thus available for use.

Treated State

Allows the selection of a sub-menu to change the treated state of the media between
Treated and Not Treated. A media can be set as treated when virtual media have been
created from this media in Xedio Browse.

Deleted State
* Deleted deletes the media from the list, but not from the database.
* Not Deleted removes the Deleted mark for the selected project or edit.

Video Standard
Allows to change the metadata for the media. This only affects the flag in the metadata
and does not affect the media (to allow for a correction in the data only).

Video Ratio

Allows to change the metadata for the media between 4/3, 16/9, and unknown. This only
affects the flag in the metadata and does not affect the media (to allow for a correction in
the data only).

Media File(s) Status

Allows the selection of sub-menu to change the status of the low bitrate file or the high
bitrate file between Rec Done, Imported, Rec Error, Archived, ArchiDel, Restored,
Deleted and Imported Error.

Set Audio Track Assignment

Allows to set or update the audio track assignment for selected media (8 audio or 5.1).
This is only allowed with media not already used See section "How to Define New Default
Audio Channel Assignment" on page 101 for explanation.

Delete Media & Purge

Allows the user to remove unused media from the media server while deleting the media
from the database.

See section "Delete and Purge" on page 47.

Force Delete
Deletes a media with all the references of its use in the database. If it is used in an edit,
this will cause “holes” in the edit. This option must be used very cautiously.

Play
Opens a new Player window to allow the low bitrate file or the high bitrate file to be
browsed and modified.
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Render List
Opens the Render List window listing all types of rendering that have been done with the .

Archive History
Opens the Archive History window listing the archive and restore processes that were
achieved for the selected .

Properties

Opens the Media Properties window which shows the properties for the selected media. If
a default metadata profile has been defined for the media, a metadata tab is displayed and
shows the media metadata. The users can modify the media metadata values.

See section "Media Profile Association" on page 64 for more information on the selection
of a profile.

Media Analyzer
Opens a Timecode Extractor window showing an analysis of the selected file.

MOS Publication
Allows to send a naotification to the news room system.

Merge
This option is used to associate a lo-res media to a hi-res media.
Opens the Get Lowres File window allowing you to browse for the lo-res file.

Generate Low Resolution Media File
Generates missing lo-res media file from the hi-res media file. See section "Generate Low
Resolution Media Files" on page 46.

Retrim
In case the TC IN or TC OUT of a media hi-res and lo-res files differ, this option will
automatically adjust both files to the same TC range.

Relink
Allows to link the file to a low bitrate or a high bitrate media file.

Create Missing Thumbnails
This option creates thumbnails in the Thumbnail IN and Thumbnail OUT columns of the
Work area.

Used By
Opens a window to show in which projects and edits the selected media is used in:

Clip_0m
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Generate Low Resolution Media Files

When several files are selected from the list and you select the Generate Low
Resolution Media File option, several cases can occur.

1. Some hi-res files are not present on the Media server (they could be offline or
ARCHIDEL)

A popup window is displayed and lists those missing files. You are asked whether you
want to continue.

o Click YES to generate only lo-res files corresponding to existing hi-res files
o Click NO to cancel the operation.

2. The hi-res files are online and at least one lo-res file already exists on the Media server
oris "ARCHIDEL".

A popup window is displayed and mentions that existing file. You are asked whether
you want to overwrite this lo-res file.

o Click YES to overwrite the existing lo-res file.

If the Do this for all selected media option is selected, the check will not be
applied on the other files and all the existing lo-res files will be generated.

o Click NO to avoid the replacement of existing lo-res files.

If the Do this for all selected media option is selected, the check will not be
applied on the other files and only the offline lo-res files will be generated.

3. The hi-res files are online and at least one lo-res file is in use.

A popup window is displayed and mentions the file in use. You are asked whether you
want to continue.

o Click YES to generate only lo-res files not in use.

o Click NO to cancel the operation.
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6.6.3.

6.7.

6.7.1.

Delete and Purge

The Delete Media(s) & Purge function allows the user to remove unused media from the
media server while deleting the media from the database.

There are four options available when using this function:
1. Delete database references: removes entries from the database only

2. Delete database references AND media files from online (e.g. XT[2]) or nearline (e.g.
SAN, XStore) storage: removes entries from the database and from the media server

3. Delete database references AND media files from offline/deep archive (e.g. Tape
library, ftp archive): removes entries from the database and from the archive storage

4. Delete database references AND media files from online/nearline storage AND media
files from offline/deep archive: removes entries from the database, from the media
server and from the archive storage

The media will be removed only if they are not used in other edits or in other playlists
(either the media itself or through attached virtual media or virtual clips).

Additionally, all associated material such as virtual media and virtual clips that are used in
the edit(s) or playlist(s) selected for deletion will be removed from the database.

See section "Media File Cleaner" on page 135 for more powerful media delete and purge
options

Searching for Elements in the List

Introduction

When the database contains large amounts of data, it may become difficult to find a
specific element. The Media Manager offers several ways to speed up your search:

* quick text search
+ filters on parameters

By default, the columns that are taken into consideration for the Quick Text Search are the
ones currently visible in the grid.

If you wish to search in other columns, and view the string you are searching for in the
columns, you can:

* add other columns to the Elements grid view
» use Filters, as explained in section "Advanced Search" on page 49.
These search tools are explained in detail below.

An applied filter can be saved for later use. Such a saved filter can then be applied in one
click.

A search can also be facilitated by ordering the Elements grid.

6. Media
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6.7.2.

Quick Text Search

Purpose and Context of Use

The Quick Text Search function is used to perform a search based on free text entered in
the Quick Text Search field. This field is available on the top of the Elements grid.

«C  Du |

It allows searching for a string in the displayed columns.

Users can enter a search string in one of the following ways.

» They enter the search string in full in the Quick Text Search field.
The Quick Text Search option obeys specific rules which can be accessed via the
Help button next to the Quick Text Search field.
See section "Quick Text Search Rules" on page 48 for more details on these rules.

» They click the arrow next to the Quick Text Search field, so the last 10 searches are
displayed, and they select one of them.

<emph:
athil

Quick Text Search Rules

The string that you enter in the Quick Text Search field is analyzed according to the

following set of rules, which can be accessed via the Help button next to the Quick
Text Search field.

The free text search is not a case sensitive operation.

Search String Search Result

Yellow card Searches for the strings "yellow" and "card", even if in two different
fields (columns), for example "yellow" in Name and "card" in
Keywords.

For example a clip named "The Yellow Man" with keywords "Red
Card" will be found, since it has yellow and card in 2 different fields.

"Yellow card” Searches for strings containing "Yellow card".

Yellow | card Searches for "yellow" or "card", even if in two different fields
(columns), for example "yellow" in Name or "card" in Keywords.
Spaces around the | sign are mandatory.

yell* Searches for "yell" at the beginning of a string.
*low Searches for "low" at the end of a string.
Ye*low Searches for strings with "ye" at the beginning and "low" at the end.
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6.7.3.

Search String Search Result

Ye*low 123 Searches for strings with "ye" at the beginning and "low" at the end

and which contains "123".

=card Searches for a string exactly equals to "card".

For example, if a field contains "yellow card", the =card condition
will not return any resullt.

="yellow card” @ Searches for a string exactly equals to "yellow card".

The use of quotes is required due to the space between "yellow" and
"card".

How to Perform a Quick Text Search

To perform a Quick Text search, proceed as follows:

1.
2.

Display the columns you wish to perform a quick search on.
Type a search string in the Quick Text Search field, based on Quick Text search

rules available from the Help button and detailed in section "Quick Text Search
Rules" on page 48.

Click the Search button to apply the Quick Text Search.

Depending on whether the AutoRefresh Filtering setting is selected or not, you may
not have to click the Search button to apply the Quick Text Search. Refer to the tab
Software > Parameter Profiles > General > General in Xedio Manager.

The search result is displayed in the grid.

To clear the applied Quick Text Search, click the red n button to the right of the
search field or select <empty> from the Quick Text Search drop-down list.

Advanced Search

Purpose and Context of Use

The Advanced Search functions are available for more detailed search operations. They
allow searches on media metadata.

From the Today tab, the filter "creation date = today" is automatically applied.

The Advanced Search fields can be displayed on the top left part of the Elements grid.

6. Media
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Advanced Search Fields Display

Displaying Advanced Search Fields

Show/Hide Filter Button

i
To display the Advanced Search fields, click the Show/Hide Filter button above the
grid.

The Advanced Search area is expanded as follows:

ALL Criteria are met - -

The Show/Hide Filter button can be displayed with two different colors:

Button Meanin

Display 9

The Show/Hide Filter button is gray when all filter criteria are hidden.
Consequently, the filters are inactive.

(gray)

n The Show/Hide Filter button is colored when the Advanced Search area is
visible, even if no filtering criterion is applied.

(colored)

Criteria Combination Field

The first field under the Show/Hide Filter button lists three options for the combination of
criteria to be taken into account during the filtering operation.

T LIEEnNa 1= m

MO Critenia iz met

Option Meaning
ALL criteria | All the criteria selected in the Filter fields displayed under the Criteria
are met Combination field must be met.
The media displayed in the Elements grid fulfill all the selected filter
criteria.

ANY criteria At least one of the criteria selected in the Filter fields must be met.
is met The media displayed in the Elements grid fulfill at least one of the
selected filter criteria.

NO criteria | None of the criteria selected in the Filter fields displayed under the

is met Criteria Combination field must be met.
The media displayed in the Elements grid fulfill none of the selected filter
criteria.
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Search Parameters List

The second field gives access to the list of available advanced search parameters. Click
the arrow next to the field to display the list.

Users are then able to add as many search fields as needed and to enter search criteria for
each of them.

Advanced Search Fields

Once a search parameter has been selected, an entire line is displayed.

L}

ALL Criteria are met

ITtiEEE Description

Element P

1 Selected search parameter.

2 Various fields used to enter the filter criteria. See section "Advanced
Search Fields Types" on page 52.

] Used to remove the corresponding filter line.

Used to add a new filter line.

Hiding Advanced Search Fields

To hide all the Advanced Search fields, click the Show/Hide Filter button again.
Consequently, all the applied filters are removed.

To remove an Advanced Search field from the Advanced Search area and thus clear the

corresponding applied filter, click the - button next to the field.
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Advanced Search Fields Types

Depending on the selected search parameter, different types of advanced search fields
will be displayed and available to enter criteria.

Timecode or Duration Parameter
Suchas TC IN, TC OUT, Duration...

FIY AR

—_

Select a logical operator in the first field

N

Enter a timecode or duration value in the second field.

Timecode Range

contait 00:00:00:00

1. Select an option from the first field
2. Enteratimecode value.

This will include, or exclude, media containing the specified timecode value.

Date
Such as Creation Date
Several Date Search filters exist.

1. Select a condition or a logical operator in the first field
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2. This will condition the next step:

o Search based on a specific date (e.g. with =...): a calendar will be displayed for
the selection of a date.

o Search based on aninterval (e.g. with [...] (between)...): two calendars are
displayed for the selection of two dates.

o Search based on a specific date calculated from the current date (e.g. with
tomorrow, last month,...): no other field appears.

bornarnoy

Time
Such as Last Rendered Date Time
Several Date Search filters exist.

1. Select a condition or a logical operator in the first field

2240g/11 16:20:12

otk
mnanth
itk
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2. This will condition the next step:

o Search based on a specific date and time (e.g. with =...): two additional fields will
be displayed, a calendar for the selection of a date and drop-down list for the
selection of time.

o Search based on a specific date and time calculated from the current date and
time (e.g. with next hour, last month,...): no other field appears.

bornarnoy

Number
Suchas DB Id

#
L=
=
2
£

—_

Select a logical operator in the first field

N

Enter a number in the second field.

Note
<> means "differs from".

Option List
Such as Video Standard

1. Select alogical operator in the first field

2. Click the - button to display the list of options available for the selected filter
parameter.

Example for the Video Standard:

YWideoStandard M PAL 5D
M HD 1080i (350
M HD 720p @50
M HD 1080p @50
M HTSC drop 50

M HD 1080i 359,94

3. Select an option from the list.
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Boolean
Such as Published

» Select Yes or No from the single criteria field.

Free Text

Such as Label

1. Select a condition in the first field.

2. Enterfree text in the second field.

How to Perform an Advanced Search

To enter search values in the Advanced Search fields, proceed as follows:

1. Choose the columns you wish to perform a search on.

i
2. Click the Show/Hide Filter button

The Advanced Search area is displayed:

ALL Criteria are met

3. Select a criteria combination from the list:

MO Critenia iz met

4. Select a search parameter from the list of parameters.

An entire line, corresponding to the selected filter parameter, is displayed:

ALL Criteria are met

Lamera
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6.7.4.

5. Enterfilter criteria as explained in section "Advanced Search Fields Types" on page
52.

For free text fields, press ENTER to apply the filter.

Otherwise, the Elements grid is automatically filtered and refreshed.

6. If required, click the button to add another advanced search parameter.

Using Saved Filters

Introduction

Once you have defined filters and search terms, you may want to save them for later use.
You will then be able to apply the same set of filters with a single click.

Saved filters appear as tabs.
At least two tabs exist on the left of the Elements grid.

» The Filter 0 tab: The Elements grid displays the list of all elements present in Xedio
Dispatcher, or it returns the result of a search applied to the list.

+ The Today tab: the Elements grid shows the elements with "creation date = today".

Warning
Those filters can be modified by the user, so the results could no longer reflect
the tab label.

Saved Filter Contextual Menu

Right-clicking in the Filter O tab displays a contextual menu with the following options:

Create New Filter
Allows to create a new filter tab through the Filter Edit Dialog wndow:

(]9

Cancel

Save Filter As
Allows to create a new filter tab in which the current search filter will be saved.

Filter Properties
Allows to change the name and/or description of the selected filter tab.

Reset Filter
Removes all search criteria on the selected filter tab.

Delete Filter
Removes the filter tab.
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How to Save Filters

To save filters, proceed as follows:

1.

4.
5.

Define the filter or filters combination you wish to save, as explained in section "How
to Perform an Advanced Search" on page 55.

Right-click the Filter O tab.

Select Save Filter As from the contextual menu.

The Filter Edit Dialog box opens.

Enter a label for the tab you are going to create and, if required, enter a description.
Click OK.

The new filter tab is displayed on the left of the list.

How to Apply a Saved Filter

To apply a saved filter, simply click the corresponding tab.
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1. Metadata

7.1. Introduction

Metadata is customer-defined data used to describe or classify A/V material.
A metadata profile is made of a set of user fields which are managed together.

Metadata user fields are created and associated into metadata profiles within Xedio
Manager, or they can be imported into the system in the form of an . XML file.

A metadata profile can be associated with various items such as media or edits and, then,
metadata values can be attributed to the item by entering specific values in the user fields.

Three items are available in the Metadata category. They are detailed in the table below.

Metadatas

tedia Profile
Edit Prafile .
Item Description
Profile Management Manages the creation of metadata fields and their

association into metadata profiles.

Media Profile Association Allows the selection of metadata profiles to be
available for association with media.

Edit Profile Association Allows the selection of metadata profiles to be
available for association with an edit.
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7.2.

7.2.1.

Profile Management

Overview of the Profile Management
Window

lHlustration

The Metadata Profiles window allows you to define user fields and to associate them into
profiles. You can access it by clicking the Profile Management button.

It contains the areas highlighted on the screenshot below:

&z
[
g:
E
B:
B8
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Area Description

The table below describes the various parts of the Metadata Profiles window:

Part Name Description

1. Available This pane is used to manage the metadata fields. It displays
Metadata Fields | the list of existing metadata fields.
See section "Managing User Fields" on page 60.

2. Metadata Profile | This pane is used to create, import or export metadata
Information profiles.
See section "Managing Metadata Profiles" on page 62.

3. Existing This pane displays the list of existing metadata profiles.
Metadata Profiles

7.2.2. Managing User Fields

How to Create User Fields
1. Click the Add New Field button in the Available Metadata Fields area.
The Metadata Field dialog box opens:
Metadata Field

Field Marne : Description

Default ¥

Max Length @ | 512 Multiplicity :+ 1
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2. Complete the following fields:

Field Description

Field Name Name you want to give to the user field.

Type Six types of user fields are available. They will appear as follows in
Xedio CleanEdit:

* Boolean: True or False values.

+ Date: Date field with drop-down arrow giving access to a
calendar.

* Text: Free text field

+ Combo: Drop-down list of values defined at creation

*  Number: Number field with up and down arrows to increase or
decrease the value.

+ Timecode: Timecode field

Default Values | Possibility to define a default value to be used for the user field. The

default value is enabled when the Default Values button is
surrounded by a red line.

Description Optional text to describe the user field.

Field Values Right-click in the field and select New to define a value for the drop-
(combo option) down list.

3.

Click the OK button.

The user field is listed in the Available Metadata fields pane.

How to Modify a User Field

1
2.
3

4.

Select it in the list.

Click the Modify Field button.

Enter new values in the relevant fields.
Click the OK button.

If the user field is used in a profile, only the Label and the Description fields can be
edited.

Note

A closed padlock icon displayed next to a user field means that the
corresponding metadata profile has been selected from the Media Metadata
Profile Table Association window or from the Edit Metadata Profile Table
Association window.

How to Delete a User Field

1.
2.

Select it in the list.
Click the Delete Field button.

It can only be deleted if it is not used in a profile.
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7.2.3.

Managing Metadata Profiles

Creating a Metadata Profile

How to Create a Metadata Profile

1. Complete the following fields in the Metadata Profile Information area:

Field Description
ID Internal ID automatically filled by the system.
GUID Mandatory parameter pre-filled with a unique ID.

This GUID is particularly important if the media/edit is exported with its
custom metadata to IPDirector. Enter the same GUID for this metadata
profile in Xedio Manager as the matching metadata profile existing in
IPDirector, so IPDirector will recognize the profile and not create a new
one.

Label Name you give to the profile.
Use the log sheet profile name existing in IPDirector if you want to
export A/V Material with its metadata in IPDirector.

Description | Optional text to describe the metadata profile.

2. Select the list of user fields you want to use in the profile: select a user field in the
Available Metadata Fields area and drag it to the Metadata Profile Information area.

3. Click the Save Profile button. The metadata profile will then be displayed in the
Metadata Profiles area.

How to Modify a Metadata Profile

1. Select it in the Metadata Profiles area

2. Add userfields from the Available Metadata Fields area to the Metadata Profile
Information area, or

select a user field in the Metadata Profile Information area and click the Remove
Field from Profile button.

3. Click the Save Profile button.

It can only be edited if it is not selected for use in the Media or Edit Profile Association.

How to Delete a Metadata Profile
1. Select it in the Metadata Profiles area
2. Click the Delete Profile button in the Metadata Profile Information area.

It can only be deleted if it is not selected for use in the Media or Edit Profile Association.
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Importing a Metadata Profile

How to Import a Metadata Profile

To import a metadata profile (.xml file) into Xedio, proceed as follows:
1. Click the Import button.

2. Browse to the selected metadata profile file.

3. Click Open.

The metadata profile is listed in the Metadata Profiles pane, provided that no metadata
profile exists with this GUID or label.

Limitations to the Import of Metadata Profile

Under certain circumstances, it will not be possible to import a metadata profile, or the
profile will be modified.

Users want to import a metadata profile with the same GUID, or the same label if there is
no GUID, as an existing profile. Then, the following situations can occur:

Situation Action

The profile has not been used (it | The existing profile can be updated with the imported

is not assigned to an element). profile.
The profile has already been The existing profile can be updated with the imported
used and the imported profile profile.

presents the user fields ina
different order.

The profile has already been The existing profile can be updated with the imported
used and the imported profile profile.
presents additional user fields.

The profile has already been Users have 3 options. The following message is
used and some user fields do not | displayed:
exist in the imported profile. bs

@ Co not update the profile at all

Cancel
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7.3. Media Profile Association

The Media Metadata Profile Table Association window allows you to select the profiles
you want to make available for media.

You can access it by clicking the Media Profile Association button.

Description :

Available : selected :

Cup Metadata Profile Prafile 1

test

Default Profile @ test

The following fields are displayed in the window:

Field Description

Description Automatically filled by the system for the selected profile with the
description text entered at profile creation.

Available Displays the list of existing profiles available for selection.

Selected Displays the list of profiles which have been selected in the

Available list and added thanks to the Add button. Profiles can be
removed from the Selected list and be made available in the
Available list again by using the Remove button.

Each user field from the selected profiles could be displayed in
additional column in Media > Manager from the Xedio Manager and
in the Media Manager tab from the Xedio CleanEdit.

Default Profile Allows the selection of a profile, from the list of Selected Profiles, to
be used as default profile when a user will associate metadata to a
media.

The Save button must be clicked to save changes.
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7.4. Edit Profile Association

The Edit Metadata Profile Table Association window allows you to select the profiles you
want to make available for edits.

You can access it by clicking the Edit Profile Association button.

Description :

Available : Selected :

Cup Metadata Profile Profile 1
test

Default Profile @ kest

The following fields are displayed in the window:

Field Description

Description Automatically filled by the system for the selected profile with the
description text entered at profile creation.

Available Displays the list of existing profiles available for selection.

Selected Displays the list of profiles which have been selected in the Available list
and added thanks to the Add button. Profiles can be removed from the
Selected list by using the Remove button.
Each user field from the selected profiles could be displayed in additional
column in Tools > Edits Manager from the Xedio Manager and in the Edit
Manager tab from the Xedio CleanEdit.

Default Allows the selection of a profile, from the list of Selected Profiles, to be
Profile used as default profile when a user will associate metadata to an edit.

The Save button must be clicked to save changes.
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8. Playouts

8.1. Introduction

The servers which will be used for payout must be defined and their parameters must be
set in Xedio Manager. They will then be available in the Playout Organizer application.

Two items are available in the Playouts category. They are detailed in the table below.

Playouts

3

Servers bManager

i

Group M anager

Item Description

Servers Manager Defines hardware setup and parameters for each playout server.

Group Manager  Allows to create groups of playout servers that make playout
channels visible only from specific Playout Organizer workstations.
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8.2.

8.2.1.

8.2.2.

Servers Manager

Introduction

When you click the Servers Manager button, the Playout Servers Manager window is
displayed in the Work area, allowing you to define each physical machine to be used for
playout.

+ B2 CEWKS3UI7
+ B3 ®STORE70110

.01 .
b= 40217 : 4021

Creating and Configuring a Playout Server

To create and configure a playout server, complete the following fields and then click on
the Create button.

The playout server name is added to the list on the left side of the window and “PCX” then
“Channel 1” appear undemeath, which corresponds to the playout channel.

Field Description

Label Name you give to the playout server, as it will appear in the list.

Playout Group | List of predefined playout groups. The GLOBAL option makes the
playout server available from all Playout Organizer workstations.

IP Address IP address of the playout server.

Port Port used for the playout.

(default = 4021)

Description Optional text to describe the playout server.

Card1/2/3 Type of card used. Several cards could be used but it is not
advisable.
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8.2.3. Modifying the Playout Server Properties

To modify the properties of a playout server, select it in the list, enter new values in the
relevant fields, and click the Update button.

8.2.4. Possible Actions with Contextual Menus

A contextual menu is available when you select a playout server in the list and then right-
click:

Menu Item Description

Duplicate Creates a new playout server with the same properties. The term
"duplicated" is added next to the new playout server name.

Delete Deletes the playout server configuration and removes it from the list.
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8.3. Group Manager

8.3.1. Introduction

The Playout Servers may be grouped together through the Group Manager. This can be
used to group a main server and a backup server. They can then be made visible only from
some predefined Playout Organizer workstations.

When you click the Group Manager button, the Playouts Group Manager window is
displayed in the Work area.

group 1 abel : aroLp 2

8.3.2. Creating a Group of Playout Servers

To create a group of playout servers, complete the following fields and then click on the
Create button.

The group name is added to the list on the left side of the window.

Field Description

Label Give a name to the group of playout servers.
Description Optional text to describe the group of playout servers.
Playout Servers Select the playout servers to group together.
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Note
A group of playout channels restricts the amount of available channels for

specific Playout Organizer workstations. There is one default group, called
GLOBAL, that allows a Playout Organizer workstation to “see” all channels
when it is selected.

8.3.3. Deleting a Group of Playout Servers

To be able to delete a group of playout servers, you first need to clear the playout servers
boxes and click the Update button.

Then, right-clicking the group name will show you a contextual menu with the Delete
Group option.
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0. Softwares

9.1. Introduction

The parameters specific to the various applications of the Xedio Suite can be stored into
different profiles. These profiles can then be selected for use by users.

Keyboard shortcuts can also be defined and stored into profiles. These profiles are linked
to the workstation.

Four items are available in the Softwares category. They are detailed in the table below.

Softwares

Farameter Profiles

®

Kepboard Profiles

K.evboard Machinesz

Yideo Fx

Item Description

Parameter Profiles Makes it possible to set and store the software parameters
of all applications into profiles.

Keyboard Profiles Makes it possible to set and store the keyboard key
assignments into profiles.

Keyboard Machines Allows to assign defined keyboard profiles to workstations.

Video FX Allows to set the name and the default parameters for the

transition effects.
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9.2. Parameter Profiles

9.2.1. Introduction

When you click the Parameter Profiles button, the Softwares Parameter Profiles window
is displayed in the Work area.

The window is divided into three areas:

Part Name Description

1 Application This area displays the applications icons for which it is possible
Selectionarea | to manage parameters and profiles.

2 Profile This area displays the available profiles that can be managed
Selectionarea | for the selected application.

3 Parameters This area gives the list of parameters. They can be edited and
area modified there.

Note

Each Xedio application must have been started and have written registry for its
corresponding icons to be available.
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9.2.2.

9.2.3.

Possible Actions with Contextual Menu

A contextual menu is available when an application is selected in the Application
Selection area and you right-click in the Profile Selection Area:

Menu o
ltem Description
New Opens the New Param Profile window where you can enter a name for the
new profile in the Label field.
Modify Opens the Modify Param Profile window allowing to update the label or
description of the selected parameter profile.
Delete Deletes the selected parameter profile.
Note
It is not possible to remove a profile that is currently in use. An
error message will be shown if this is attempted.
Import Import a parameters profile stored in a .ini format.
from File | Inthe Open window, select the file that contains the parameters profile to
import.
Import Import a parameters profile stored in a .ini format as the default parameter
Default profile.
In the Open window, select the file that contains the parameters profile to
import.
Export to | Exports the selected parameters profile in a readable file (.ini format).
File In the Save As window, select the folder to export the file to.
Export to  Exports the selected parameters profile in a text file format (.txt format).
Text In the Save As window, select the folder to export the file to.

List of <GENERAL> Parameters

General

Enable Windows When selected: all the Xedio client applications use
Authentication (Active = Windows authentication (Active Directory) without

Directory)

requesting additional access codes, except Xedio Manager
which gives the choice between using Windows
authentication or Xedio authentication.

Allows to backup EVS | When selected: the backup of EVS video server is allowed.
video server
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Auto Refresh Filtering

Can select ClassList
node

Confirmation window
to backup EVS video
server

Default video aspect
ratio

Default high bitrate
video width

Default Proxy Video
Frequency

Default Proxy Video
Resolution

Default video standard

Default XT Growing
Clip Duration

Gop browsing accuracy
for hi-res player

Gop browsing accuracy
for lo-res player

Grab Still Frame Folder
Grab Still Frame Prefix

Notification Center IP
address

Notification center
network port

Odd Frame Clipping

When selected: each time a new criterion is added to a
filter, the search is automatically started without pressing
Return or clicking the Search button.

When selected: enables the selection of a class list node
rather than only the deepest sub-items.

When selected: displays a confirmation window before the
backup operation of an EVS video server.

Video Ratio used in thumbnail generation and during
rendering operations.
Possible values: 4/3 or 16/9.

Free text field to define the default horizontal resolution for
hi-resolution video files (width in pixels).

Default video frequency for Proxy video browsing, editing
and encoding.

Default video resolution for Proxy video browsing, editing
and encoding.

Video supported by the Dispatcher in the current session
(You cannot mixed PAL and NTSC). This parameter is also
used during rendering to upscale or not the media

Possible values: PAL SD, NTSC drop SD, HD 1080i
@50, HD 720p @50, HD 1080i @59,94, HD 720p
@59,94.

Field to define the default duration for XT growing clip.

Defines the value under which the player display will be
updated when browsing the nowline (ms).

Defines the value under which the player display will be
updated when browsing the nowline (ms).

Field to define the default folder to store grab image file.

Field to define the default prefix for the resulting grab image
file.

Free text field to define the |P address of the notification
center.

Free text field to define the port number of the notification
center.

When selected: enables clipping on odd frames when
working with P resolution in all players and timelines.

Note
This parameter should only be set for full
progressive workflows.
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Precise browsing
accuracy for hi-res
player

Precise browsing
accuracy for lo-res
player

Timecode size (ratio)

XedioBroker IP address

XedioBroker network
port

XT Clip creation default
clipname

Defines the value under which the player display will be
updated accurately when browsing the nowline (ms).

Defines the value under which the player display will be
updated accurately when browsing the nowline (ms).

Sets the timecode display size in the player pane. The value
corresponds to the ratio of the timecode display rectangle
towards the largest siez of the video display.

Default value: 30.

Range of values: 1 -100.

Free text field to define the |P address of Xedio Broker.

Free text field to define the port number of Xedio Broker.

Free text field to define the default clip name when creating
an XT clip.

Audio

Default Input Audio
Track Assignment

Default Rendering
Audio Track
Assignment

Default XT Input Audio
Track Assignment

Defines the default audio channel assignment for the
imported media files (other than server clips and encoder
ingests).

The field displays the assignments for 2, 4, 8 and 16
channels configurations separated by a"|" sign:

STIST +M +M[5T +5T +51 +5T + 5T + 5T

T =5 [L-RLIL-RLLFA-C-LFE-LS RSLLRLLRLLR]
See section "How to Define New Default Audio Channel
Assignment" on page 101.

Note

Once the audio track assignment has been defined
in Xedio Importer or AutoFile Importer, these values
will be used instead of the default ones on the
workstation.

Defines the default audio channel assignment for rendered
files.

The field displays the assignments for 2, 4, 8 and 16
channels configurations separated by a"|" sign.

Defines the default audio channel assignment for the media
files (server clips only). The field displays the assignments
for 2, 4, 8 and 16 channels configurations separated by a "|"
sign.
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Enable 5.1 management Enables the creation of 5.1 tracks in CleanEdit timeline. The
5.1 audio support in CleanEdit works only with EVS video
server clips. Each track created in the CleanEdit timeline
allows the user to place and manage audio blocks from
server clips, behind which a group of 6 audio channels are

handled.
Enable mono tracks Enables the creation of mono tracks in CleanEdit timeline.
Automatic Restore
Restore Type Option list to select the restore type to be used for

automatic restore process.

Possible values:

* Full Restore: restores the whole media

+ Partial Restore: restores only the useful section of the
media used in the edit for which a restore is requested.
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Import

Imported ClipName
Format

Imported FileName
Format

Use Long Clip Name

Field to define the format string which will be used to create
the clips name in the database during XDCAM import when
the merge option is used.

The following items can be used:

%SHOTNAME Clip Label on the original device

%ORIGINTC

TC IN of the clip on the original device

%NEWGENTC TC IN of the clip in the new file

Field to define the format string which will be used to create
the file name during XDCAM import.
The following items can be used:

%LABEL
%NAME
%CLASSID
%TCIN
%TCOUT
%CLIPTYPE
%USER
%DURATION
%YEAR
%MONTH
%DAY
%HOUR
%MIN
%SEC
%MSEC
%SDYEAR
%SDMONTH
%SDDAY
%GUID

Label given by Xedio user

Clip Name

Class ID

Timecode IN

Timecode OUT

Clip Type, e.g. DV_50i, P2HD_100i)
Xedio Username

Timecode Duration

Current Year

Current Month

Current Day Number

Current Hour

Current Minute

Current Second

Current Millisecond

Shooting Date — Year

Shooting Date — Month Number
Shooting Date — Day Number
ClipGUID

When selected: the long clip name is used as media label.

Vumeter

Bottom level of
Vumeter

Saturation level of
Vumeter

Field to define the db value of vu-meter bottom level. It is
the audio level difference (in dB) compared the 0 level (audio
level of the source media) and corresponding to the bottom
of the green zone in the audio meters

Field to define the db value of vu-meter saturation level. It is
the audio level difference (in dB) compared to the 0 level
(audio level of the source media) and corresponding to the
bottom of the red zone in the audio meters
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9.2.4.

Top level of Vumeter

Warning level of
Vumeter

Field to define the db value of vu-meter top level. It is the
audio level (in dB) of the source media and corresponds to
the top of the red zone in the audio meters.

Field to define the db value of vu-meter warning level. This
value corresponds to the beginning of the orange area in the
vu-meter.

Note

The default values for audio vumeter levels differ in Xedio and in Final Cut Pro.
It is therefore normal to see the same media reaching the red zone in Xedio
while it is still in the orange zone in FCP.

If you want to have the same audio meter display in both applications, you can
match the audio meter default values in Xedio Manager to the FCP values.

List of Parameters for Xedio Manager

The Xedio Manager profile gives access to the following lists of parameters (tabs).

General

Convert IP to Machine
Name

When selected: the IP address is converted to machine
name for display.

Cefiltermgr

Max Date Interval

Max Result Set Size

Recent Date List

Field to define the maximum date interval, in days, which
can be used when a search filter is applied on a date
parameter (0 = no limit).

Field to define the maximum number of items which will be
displayed in the result list after a search filter has been
applied (0 = no limit).

Free text field to define the dates to be displayed in "recent
dates" drop-down lists.

Cemediaimport

Enable Audio Track
Assignment Dialog

Canon

Enable Merging
Durations Check

Enable No Merging
Durations Check

When select: Enables the display of audio track assignment
dialog tab in the Setup window during an import.

When selected: Allows import from Canon device.

When selected: the durations of the high resolution and low
resolution files are checked to ensure that they match, after
their import with merge.

When selected: the durations of the high resolution and low
resolution files are checked to ensure that they match, after
their import without merge.
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9.2.5.

Enable RTD Import

LoResGen Rendering
Profile

P2

PlayXTClip
PlayXTTrain

Enable Image Import

Enable Stills Key
Import

Enable Video Import
Enable Wave Import
Enable XDCam Import
XDCamEX

Allow XT Import

When selected: Allows import of RTD files

Field to select the rendering profile used to regenerate the
low resolution file.

When selected: Allows import of files with P2 format
When selected: Allows server clip to be viewed in a player
When selected: Allows server train to be viewed in a player
When selected: Allows import of image (stills files)

When selected: Allows import of stills with key files

When selected: Allows import of video files

When selected: Allows import of files with wave format
When selected: Allows import of files with XDCam format
When selected: Allows import from XDCamEX device

When selected: Allows import of server clips

Media Manager

LoResGen Media
Server

LoResGen Rendering
Profile

Xedio Media server where the low-resolution media file shall
be (re)generated.

Low-resolution rendering profile used to generate the low-
resolution media file.

Scheduler

Scheduler Published

Scheduler ReadOnly

Default value of the Publish check box when creating a
record from the Scheduler.

Possible values are: published, not published or previous
state.

When selected: restricts the Scheduler access to read-only;
records cannot be created or modified.

List of Parameters for Xedio CleanEdit

The CleanEdit profile gives access to the following lists of parameters (tabs).

An Effects area is displayed in the lower part of the window. Selecting effects allows the
users to use them in CleanEdit. The video transition effects are: Mix, Wipe, Border
Wipe, Dip to Color. The video clip effects are: Grey, Horiz(ontal) Mirror, Film Effect,
Color Fade, Color Correction, Highlight, Blur, Zoom Linear.

Refer to the Xedio CleanEdit manual for a description of each effect.
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General

Auto Refresh Filtering

Check for missing hires
files

Active Window Color

Show confirmation
dialog

Automatic Edit ID
Generation

Read Only Edit ID

EVS Server Ganging
Type

External Cue Point —
Ranking 0 Color

External Cue Point —
Ranking * Color

External Cue Point —
Ranking ** Color

External Cue Point —
Ranking *** Color

Mandatory Edit On-air
Date

Show ArchiveMgr TAB
Show Devices TAB
Show Edit TAB

Show EditMgr TAB

Show HeaderMaker
TAB

When selected: each time a new criterion is added to a
filter, the search is automatically started without pressing
Return or clicking the Search button.

When selected, checks for missing hi-res files in the edit
timeline and displays a small yellow triangle over each
missing clip in the timeline.

Option list to select the color used for the rectangle under
the active Player area or Recorder area.

When selected: Shows a confirmation dialog window when
doing delete actions

Enables automatic Edit ID generation and selects the

generation method.

Possible values:

*  None

+ |IDDB: unique in the DB but maybe not across several
DB

* UUID: Universally Unique Identifier (UmID)

When selected: sets the Edit ID property to read-only

Field to enter a value corresponding to a camera ganging

type.

0: XT input cameras

1: IPDirector metadata

2: mixed (first tries IPD metadata then XT input cams)

Color used, in the media bar of the Player, to represent a log
with the default ranking assigned

Color used, in the media bar of the Player, to represent a log
with a ranking * assigned

Color used, in the media bar of the Player, to represent a log
with a ranking ** assigned

Color used, in the media bar of the Player, to represent a log
with a ranking *** assigned

When selected: the on air date of an edit is mandatory

When selected: shows the ArchiveMgr TAB in CleanEdit
When selected: shows the Devices TAB

When selected: shows the Edit TAB

When selected: shows the EditMgr TAB

When selected: shows the Header Maker TAB
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Show Medialmporter
TAB

Show MediaMgr TAB
Show Playout TAB
Show ProjectMgr TAB
Show Export TAB
Show Scheduler TAB
Show TaskViewer TAB

Show
CharacterGenerator
TAB

Show VoiceOver TAB
Show VTR TAB
ThumbnailWidth

User Cue Point Color

When selected: shows the Medialmporter TAB

When selected: shows the MediaMgr TAB
When selected: shows the Playout TAB
When selected: shows the ProjectMgr TAB
When selected: shows the Export TAB
When selected: shows the Scheduler TAB
When selected: shows the TaskViewer TAB

When selected: shows the CharacterGenerator TAB

When selected: shows the VoiceOver TAB
When selected: shows the VTR TAB

Width used for new thumbnails (Height is found according
to the 4/3 ratio)

Color used, in the media bar of the Player, to represent a log
entered by the logged user.

Archive

Archive Default Priority

Archive Hi Res

Archive Low Res

Delete Free Files
Delete Hi Res
Delete Low Res

Restore Default Priority

Restore Hi Res
Restore Low Res

Check Locked Media in
Media List

Field to enter a value corresponding to the default archive
request priority. This value is transmitted when the system
is integrated with DIVA.

Possible values: from 0 to 100, with 0 = disabled, 1 = lowest
priority and 100 = highest priority.

When selected: archives high resolution files when an
archiving is requested.

When selected: archives low resolution files when an
archiving is requested.

Not implemented
When selected: deletes high resolution files after archiving.
When selected: deletes low resolution files after archiving.

Field to enter a value corresponding to the default restore
request priority.

Possible values: from 0 to 100, with O = disabled, 1 = lowest
priority and 100 = highest priority.

When selected: restores high resolution files
When selected: restores low resolution files

When selected: allows the user to check for locked media.
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Automatic Restore

Restore Priority Edit
Clip

Restore Priority R2B

Field to enter a value corresponding to the Restore Priority
when a clip is dropped in the timeline or when Edit Play date
is modified.

Possible values: from 0 to 100, with O = disabled, 1 = lowest
priority and 100 = highest priority.

Field to enter a value corresponding to the Restore Priority
when an Edit is set to Ready to Broadcast.

Possible values: from 0 to 100, with 0 = disabled, 1 = lowest
priority and 100 = highest priority.

Browser

Base for new project

Base for new edit

Base for new clip

Free text field to enter the default base name for a new
project.

Free text field to enter the default base name for a new edit.

Free text field to enter the default base name for a new clip.

Video standard When selected: enables the selection of the video
selection standards.
Cefiltermgr

Allow Change Edit
Properties

Allow Change Media
Properties

Max Date Interval

Max Result Set Size

Recent Date List

When selected: allows the user to change edit properties in
Edit Manager.

When selected: allows the user to change media properties
in Media Manager.

Field to define the maximum date interval, in days, which
can be used when a search filter is applied on a date
parameter (0 = no limit).

Field to define the maximum number of items which will be
displayed in the Elements grid after a search filter has been
applied (0 = no limit).

Free text field to define the dates to be displayed in "recent
dates" drop-down lists.

Cemediaimport

Audio Track
Assighment Dialog

Automatic Device Scan

Canon

When selected: Enables the display of audio track
assignment dialog tab in the Setup window during an import.

When selected: Automatically scans devices at start up.

When selected: Allows import from Canon device.
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Enable Merging
Durations Check

Enable No Merging
Durations Check

Kmt

LoResGen Rendering

Profile

P2
PlayXTClip
PlayXTTrain
Stills

Stills Keys
Video
Wave
XDCam
XDCamEX
XT

When selected: the durations of the high resolution and low
resolution files are checked to ensure that they match, after
their import with merge.

When selected: the durations of the high resolution and low
resolution files are checked to ensure that they match, after
their import without merge.

When selected: Allows import of RTD files

Field to select the rendering profile used to regenerate the
low resolution file.

When selected: Allows import of files with P2 format

When selected: Allows server clip to be viewed in a player
When selected: Allows server train to be viewed in a player
When selected: Allows import of image (stills files)

When selected: Allows import of stills with key files

When selected: Allows import of video files

When selected: Allows import of files with wave format
When selected: Allows import of files with XDCam format
When selected: Allows import from XDCamEX device

When selected: Allows import of server clips

Cerendering2

Available XTNr

Id RTProf Agent

Id Shell Agent

Id To XT Agent

Show To CleanEdit
Show To Device
Show To File

Show To Target

Free text field to enter a comma-separated list of numbers
for available EVS video server. If the field is left empty, all
numbers between 1 and 30 are allowed.

Field to enter the DB ID of RTProf agent. If the field is set to
0, the first available agent with a name containing
"RTProfAgent" is fetched from DB.

Field to enter the DB Id of Shell agent. If the field is set to O,
the first available agent with a name containing 'ShellAgent'
is fetched from DB.

Field to enter the DB Id of ToXT agent. If the field is set to 0,
the first available agent with a name containing 'ToXTAgent'
is fetched from DB

When selected: shows the "To CleanEdit" TAB
When selected: shows the "To Device" TAB
When selected: shows the "To File" TAB
When selected: shows the "To Target" TAB
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Cg

Default CG Duration

Default CG Fade IN
Duration

Default CG Fade OUT
Duration

Enable Import Picture

Enable Save As
Template

Enable Subtitle File
Import

Field to enter the default duration for a new CG.

Field to enter the default duration for a CG Fade IN effect.

Field to enter the default duration for a CG Fade OUT effect.

When selected: the Import Picture button is displayed in
the Text tab of CleanEdit.

When selected: the Save as template button is displayed
in the Text tab of CleanEdit.

When selected: the Import Subtitle File button is
displayed in the Text tab of CleanEdit.

DeviceFilter

Allow CDRom

Allow Fixed Drive

Allow Ram Disk

Allow Remote Drive

Allow Removable Drive

Allow To Change
Extensions

Days Before Media
Purge

Delay Between Volume
Check

Extensions

Max Depth

Media Classld

Media Description

When selected: Allows scanning CDRoms to find media.
This parameter needs to be active for XDCAM disk access.

When selected: Allows scanning local hard disks to find
media

When selected: Allows scanning Ram disks to find media

When selected: Allows scanning network drives to find
media

When selected: Allows scanning USB drives to find media

When selected: Allows to change the list of default file
extensions supported during the media referencing from a
drive. Change is possible from the drive creation window or
the drive edit window.

Delay between two unused media purge

Time in seconds between automatic rescan on removable
disk if there is a change

List of default file extensions supported by Xedio CleanEdit
during the media referencing from a drive. This parameter is
used as default value during the drive creation.

Number of directory levels checked when scanning for
media.

Class ID assigned to the media during its referencingin
Xedio CleanEdit.

Default text to describe the media and assigned to the
media during its referencing in Xedio CleanEdit.
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Media External Ref

Media Global Shooting

Date

Media label

Media Metadata XML

Default text for the external reference of the source support
assigned to the media during its referencing in Xedio
CleanEdit.

The global shooting date is assigned to the media during its

referencing in Xedio CleanEdit.

This parameter is a numeric value to define how the global

shooting date is assigned:

Possible values:

« 0: date retrieved from the XML file and corresponding to
the date when the media was recorded by the camera.

» >0: date provided by the application .and corresponding
to the date when the media was referenced in Xedio
Dispatcher.

Default name assigned to. the media during its referencing
in Xedio CleanEdit.

This field is left empty by default.

HeaderMaker

Template Path

Free text field to enter the path to HeaderMaker template.

Media List

Max Result Sel Size

Field to define the maximum number of items which will be
displayed in the Elements grid after (O = no limit).

Player

Auto Clip IN

Auto Clip OUT

Enable Deinterlace
Menu

Jog Audio Threshold
HI

Jog Audio Threshold
LO

Jog Range HI
Jog Range LO
PrevNextX

Shift Speed Max

Amount of fields before the entry point of a clip when using
the auto-clipping tool (Alt+Space bar).

Amount of fields after the out point of a clip when using the
auto-clipping tool (Alt+Space bar).

When selected: enables the Deinterlacer menu (hi-res mode
only).

Field to enter the jog browsing speed limit for the audio to be
decoded in hi-res.

Field to enter the jog browsing speed limit for the audio to be
decoded in lo-res.

Field to enter the jog range in hi-res.
Field to enter the jog range in lo-res.

Field to enter the number of fields to jump when Alt key is
used with Prev and Next buttons.

Field to enter the speed rate for super fast forward and
rewind tools when used together with the Shift key.
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Speed Max

XT Clip Creation Time

Tolerance

XT Stream Creation
Time Tolerance

XT Train Only View
Enable

Field to enter the speed rate for fast forward and fast rewind
tools.

Field to enter the tolerance value (in seconds) towards the
creation time between two sibling XT clips.

Field to enter the tolerance value (in seconds) towards the
creation time between two sibling streams.

When selected: the clip creation on XT train is disabled.

Recorder

Enable Deinterlace
Menu

When selected: enables the Deinterlacer menu (hi-res
mode only).

PreRoll Field to enter the Preroll time, in fields, used to play
previous/next transition
PrevNextX Field to enter the number of fields to jump when Alt key is
used with Prev and Next buttons.
RoliBoth When selected: enables the left roller and right roller tools.
RollLeft When selected: enables the left roller tool
RollRight When selected: enables the right roller tool
RollTurn When selected: enables the clip roller tool
Scheduler
Read Only When selected: restricts the Scheduler access to read-only;
records cannot be created or modified.
Timeline

Audio Auto FX
Audio Effects

Audio Fade IN Dur

Audio Fade IN Pos

Audio Fade OUT Dur

When selected: enables automatic audio transition effect.

When selected: enables graphical audio transition effects
adjustments when zooming audio tracks

Field to enter the duration, in fields, of the audio fade effect
at the IN point. This will be displayed in the “fx” dialog box,
“Audio fade” tab.

Option list to select the position of the audio fade effect at
the IN point. This will be displayed in the “fx” dialog box.
Possible values: None, Before OUT, Centered, After OUT.

Field to enter the duration, in fields, of the audio fade effect
at the OUT point. This will be displayed in the “fx” dialog
box, “Audio fade” tab.
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Audio Fade OUT Pos

Audio Level Adjust

Audio Level Max

Audio X Fade Dur

Audio X Fade Pos

Block Font Height

Block Font Name

Can Accelerate

Clips Move

Clips Move Sensibility

Color Block Width

Default Audio Trans FX

Default Video Trans FX

Fast Motion Clip HR

Fast Motion Clip LR

Fx Tab Audio Fade

FX Tab Audio Level

FX Tab Color Ins

Fx Tab Video Fade

Option list to select the position of the audio fade effect at
the OUT point. This will be displayed in the “fx” dialog box.
Possible values: None, Before OUT, Centered, After OUT.

Field to enter the default audio level value to be displayed in
the FX dialog box.

Field to enter the maximum audio level adjustment value to
be displayed in the FX dialog box.

Field to enter the default audio fade duration to be displayed
in the “fx” dialog box, “Audio fade” tab.

Option list to select the audio cross fade position.
Possible values: None, Before OUT, Centered, After OUT.

Field to enter the text font size in timeline block.
Option list to select the text font name in timeline block.
When selected: enables fast motion.

Field to enter the number of fields to shift the selected clips,
to the left or to the right, when used in combination with + or
—key.

Field to enter the mouse sensitivity value when selecting
and moving blocks inside the timeline.

Field to enter the size of the color area within timeline
blocks.

Option list to define the default audio transition effect.
Possible values: None, Fade OUT, Fade IN, Cross Fade.

Option list to define the default video transition effect.
Possible values: Mix, Wipe, Border Wipe, Dip to Color.

Option list to select the transcoding codec used for the
rendering of hi-res Fast Motion Clip.

Possible values: list of codecs available with the current
release package.

Option list to select the transcoding codec used for the
rendering of lo-res Fast Motion Clip.

Possible values: list of codecs available with the current
release package.

When selected: enables the Audio Effect tab in the Fx
dialog.box.

When selected: enables the Audio Level Adjustment tab in
the FX dialog box.

When selected: enables the Color Clip Tool tab in the FX
dialog box.

When selected: enables the video Fade tab in the FX dialog
box.
Note: this is not supported.
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Guardband Frames
Graphics Insert
Duration

Magnet Pixels

Max Display DB

Max Fast Motion Speed

Reset To Default

Show Audio Matrix
Buttons

Show Default Audio
Channel Buttons
Show TC In Out
Tag_External Graphics
Tag_Logo Insertion

Tag_Viz

Tag Default Duration
Tag Label List

Tag Properties

Use Tag Labels

Use Tag Templates

Video Auto FX

Video Color Dur

Video Color Ins

Video Effects

Field to enter the minimum duration value when adjusting
clip duration using the rollers.

Field to enter the default duration for inserted graphics.

Field to enter the sensitivity value of the magnetic effect
during drag-and-drop operations on timeline clips.

Field to enter the maximum displayed value for audio level.

Field to enter the maximum allowed value in the Fast Motion
speed dialog box (in percent) if the "CanAccelerate"
parameter is set to 1.

When selected: resets the toolbar when creating a new edit

When selected: displays the Audio Matrix button in the
CleanEdit interface.

When selected: displays the Default Audio Channel
buttons.

When selected: displays the timecodes (IN and OUT) in the
timeline blocks.

When selected: enables the External Graphics tab in tag
properties dialog box.

When selected: enables the Logo Insertion tab in tag
properties dialog box.

When selected: enables the Viz tab in tag properties dialog
box.

Field to enter the default tags duration.

When selected: uses label list for tags.
Otherwise, free text is used.

When selected: enables the Tag Properties dialog box and
the Add Tag option from contextual menu.

When selected: enables the Label field in the External
Graphics tab of the Tags dialog box.

When selected: enables the Template field in the External
Graphics tab of the Tags dialog box.

When selected: enables automatic video transition effect.

Field to enter the length of the clip created with the "color
insertion tool".

Option list to select the color of the clip created with the
"color insertion tool".

When selected: enables video transition effects
adjustments.
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TL Buttons

Afx When selected: displays the AFX button above the
timeline.

Align Left When selected: displays the Align Left button above the
timeline.

Align Right When selected: displays the Align Right button above the
timeline.

Blank Clear When selected: displays the Blank Clear button above the
timeline.

Blank Delete When selected: displays the Blank Delete button above
the timeline.

Blank Fill When selected: displays the Blank Fill button above the
timeline.

Clip Selector When selected: displays the Select All button (after/before
nowline) above the timeline.

Color Insert When selected: displays the Color Insert button above the
timeline.

Cue When selected: displays the Cue Tool button above the

Cut Copy Paste

Extend

Extend Slow

Extend Still

Fx

In Out Delete

Invert

Mark Clip

Mark IN

Mark OUT

timeline.

When selected: displays the Cut, Copy and Paste buttons
above the timeline.

When selected: displays the Extend button above the
timeline.

When selected: displays the Extend Slow button above the
timeline.

When selected: displays the Extend Still button above the
timeline.

When selected: displays the FX button used to call the FX
the dialog box above timeline.

When selected: displays the In Out Delete button above
the timeline.

When selected: displays the A/B button above the timeline.

When selected: displays the Mark Clip button above the
timeline.

When selected: displays the Mark In button above the
timeline.

When selected: displays the Mark Out button above the
timeline.
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Mark Reset When selected: displays the Mark Reset button above the
timeline.

Move Frame When selected: enables the Move Frame edit zone.

Overwrite When selected: displays the Insert/Overwrite button above
the timeline.

Rendering When selected: displays the Rendering button above the
timeline.

Split When selected: displays the Clip Split button above the
timeline.

Undo Redo When selected: displays the Undo and Redo buttons
above the timeline.

Vix When selected: displays the VFX button above the timeline.

TL Colors
Audio Block Audio block color

Audio Block With FX
Audio Hatching
Audio Text

Audio Trace Color
Drag Audio Trace
Drag Video Trace
Mark IN

Mark OUT

NowLine

Rendered Video Block
Selected Blocks

Sync Block

Video Block

Video Block With FX
Video Hatching
Video Text

VO Text

VO With Attenuation

VO Without Attenuation

Color for audio block with FX

Audio block hatching color

Audio block text color

Audio level color

Color for the audio level when adjusting
Color for the video transition duration when adjusting
Mark IN line color

Mark OUT line color

Nowline color

Rendered video block color

Selected timeline blocks color

Color for audio block which has been moved out of sync
with its associated video.

Video block color

Color for video block with FX
Video block hatching color

Video block text color

VO block text color

Color for VO block with attenuation

Color for VO block without attenuation
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Voiceover

Attenuation Auto

Attenuation DB

Attenuation Fade

Attenuation Pos
Latency Delay Offset
(msec)

PreRoll

Text Mask

When selected: enables the voice over auto-dim mode
(automatic attenuation of all the audio channels from the
same output than the voice over for the voice over duration).

Field to enter the value (DB) for automatic audio level
attenuation of audio channels for the voice over duration.

Field to enter the fade length, in fields, to reach the audio
level set with the Attenuation DB parameter.

The recommended value for voice over with an external
mixer is 2 fields.

Option list to select the Attenuation Fade position.
Possible values are: None, before cut, centered, after cut.

Field to enter a value for audio signal latency (delay) when
using an external audio capture device.

Field to enter the Preroll time, in fields, used to play voice
over.

Field to enter the voice over default base name.

9.2.6. List of Parameters for Xedio Ingest

The Xedio Ingest profile gives access to the following lists of parameters (tabs).

General

Default Media Class

Crash published

Show VTR

Option list to select the Media class to be used by default
during ingest.

Possible values: Media classes defined under Media >
Class Manager.

Option list to define whether a crash record will
automatically be published.
Possible values: Not Published, Published, Previous State.

When selected, shows the VTR parameters.

Scheduler

Scheduler published

Option list to define the publish state of the ingest from the
Scheduler in Xedio Ingest.
Possible values: Not Published, Published, Previous State.
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VTR

VTR published

Option list to define the default value of the Publish box

when creating a record from VTR.

Possible values: Not Published, Published, Previous State.

9.2.7. List of Parameters for Xedio Playout

Organizer

The Playout Organizer profile gives access to the following lists of parameters (tabs).

Cefiltermgr

Max Date Interval

Max Result Set Size

Field to define the maximum date interval, in days, which
can be used when a search filter is applied on a date
parameter (0 = no limit).

Field to define the maximum number of items which will be
displayed in the result list after a search filter has been
applied (0 = no limit).

Playout Organizer

Automatic restore
priority

Enable Play Pause

Force Approval

Hide Start on time

When adding an ARCHIDEL clip to a playlist, an automatic
restore is launched if the broadcast date and time is
foreseen within 24 hours.

This parameter sets the priority of the restore.

Possible values: from 0 to 100, with O = disabled, 1 = lowest
priority and 100 = highest priority.

When selected: the Play button switches to the Pause
button as soon as the Play button is clicked from Xedio
Playout Organizer.

When cleared: the Play button becomes unavailable as
soon as it is clicked from Xedio Playout Organizer. It does
not switch to the Pause button. Only the Stop button is
available.

When selected: forces DB objects to be approved before
their insertion into a playlist.

When selected: hides the Start on-time button.
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9.2.8.

List of Parameters for Xedio Browse and
Xedio Browse (VC)

The Xedio Browse profile gives access to the following lists of parameters.

General

Lock Published

When selected: items are locked as soon as they have
been published.

Lock Treated When selected: items are locked as soon as they have
been treated.
Test Overlap When selected: a check is performed to ensure that no
overlapping virtual media are created.
Text Mask Field to enter the default base name for a new virtual media.
Cefiltermgr

Max Result Set Size

Field to define the maximum number of items which will be
displayed in the result list after a search filter has been
applied (0 = no limit).

Player

EnableDeinterlaceMenu

Jog Range HI
Jog Range LO
PrevNextX

Shift Speed Max

Speed Max

Displays the Deinterlacer option and menu when right
clicking over the player.
This is only used in HiRes mode.

Field to enter the jog range in hi-res.
Field to enter the jog range in lo-res.

Field to enter the number of fields to jump when Alt key is
used with Prev and Next buttons.

Field to enter the speed rate for super fast forward and
rewind tools when used together with the Shift key.

Field to enter the speed rate for fast forward and fast rewind
tools.
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9.2.9.

List of Parameters for Xedio Approval

The Xedio Approval profile gives access to the following lists of parameters.

General

Lock Validated

When selected: items are locked as soon as they have
been validated.

AutomaticRestore

Restore Priority Edit
Clip

Field to enter a value corresponding to the Restore Priority
when an edit play date is modified.

Possible values: from 0 to 100, with 0 = disabled, 1 = lowest
priority and 100 = highest priority.

Cefiltermgr

Allow Change Edit
Properties

Allow Change Media
Properties

Max Result Set Size

When selected: allows the user to change edit properties in
Edit Manager.

When selected: allows the user to change media properties
in Media Manager.

Field to define the maximum number of items which will be
displayed in the result list after a search filter has been
applied (0 = no limit).

Player

Enable Deinterlace
Menu

Jog Range HI
Jog Range LO

Play LoRes if HiRes is

offline

Video Output Type

Output Video Definition

Displays the Deinterlacer option and menu when right
clicking over the player.
This is only used in HiRes mode.

Field to enter the jog range in hi-res.
Field to enter the jog range in lo-res.

Play the low resolution file if the high resolution file is not
available (e.g. archived).
Possible values: 1 = enabled, 0 = disabled.

Option list to select the video output type.
Possible values: VGA, PCX1/PCX2, PCXa.

Option list to select the default video output mode for VGA
and PCXa3.
Possible values: SD, HD1080i.
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9.2.10. List of Parameters for Xedio Importer

The Xedio Importer profile gives access to the following list of parameters.

Cemediaimport

Audio Track
Assignment Dialog

Automatic Device Scan
Canon

Enable Merging
Durations Check

Enable No Merging
Durations Check

Kmt

Lo Res Gen Rendering
Profile

P2
PlayXTClip
PlayXTTrain
Stills

Stills Keys
Video

Wave
XDCam
XDCamEX
XT

When selected: enables the display of audio track
assignment dialog tab in the Setup window during an import.

When selected: Automatically scans devices at start up.
When selected: Allows import from Canon device.

When selected: the durations of the high resolution and low
resolution files are checked to ensure that they match, after
theirimport with merge.

When selected: the durations of the high resolution and low
resolution files are checked to ensure that they match, after
their import without merge.

When selected: allows import of RTD files.

Field to select the rendering profile used to regenrate the low

resolution file.

When selected: allows import of files with P2 format
When selected: allows server clip to be viewed in a player.
When selected: allows server train to be viewed in a player.
When selected: allows import of image (stills files).
When selected: allows import of stills with key files.
When selected: allows import of video files.
When selected: allows import of files with wave format.
When selected: allows import of files with XDCam format.
When selected: allows import from XDCamEX device.

When selected: allows import of server clips.
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9.2.11.

List of Parameters for Xedio Explorer

The Xedio Explorer profile gives access to the following lists of parameters.

General

Automatic Edit ID
Generation

Read-Only Edit ID

Program Class to set
when checking MOS
published

Displays MOS Publish

Indicator

MOS publish default

Is Program Class set
when checking MOS
published read-only?

Enables automatic Edit ID generation and selects the
generation method.
Possible values:

*  None
+ |DDB: unique in the DB but maybe not across several
DB

* UUID: Universally Unique Identifier (UmID)
When selected: sets the edit ID property to read-only.

Option list to select the Program Class to be used by default
when the exported items are published to the MOS ("Allow
to MOS-publish exported edits" option selected).

Possible values: Program classes defined under Tools >
Program Class Manager.

When selected: displays the MOs Publish indicator.

When selected: select the MOS Publish parameters by
default.

When selected: sets the Program Class even if the "Read-
only Edit ID" option has been selected.

Cefiltermgr

Allow Change Edit
Properties

Allow Change Media
Properties

Max Date Interval

Max Result Set Size

Recent Date List

When selected: allows the user to change the edit
properties in Edit Manager.

When selected: allows the user to change the media
properties in Media Manager.

Field to define the maximum date interval, in days, which
can be used when a search filter is applied on a date
parameter (0 = no limit).

Field to define the maximum number of items which will be
displayed in the result list after a search filter has been
applied (0 = no limit).

Free text field to define the dates to be displayed in "recent
dates" drop-down lists.
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9.2.12. List of Parameters for Xedio Cutter

The Xedio Cutter profile gives access to the following lists of parameters.

General
Automatic Edit ID When selected: The Edit ID will be automatically generated
Generation according to the selected generation method.
Possible values:
*  None
+ |DDB: unique in the DB but maybe not across several
DB
* UUID: Universally Unique Identifier (UmID)
Read-Only Edit ID When selected: sets the edit ID property to read-only.

Program Class to set Option list to select the Program Class to be used by default

when checking MOS when the exported storyboards are published to the MOS

published ("Allow to MOS-publish exported edits" option selected).
Possible values: Program classes defined under Tools >
Program Class Manager.

Displays MOS Publish | When selected: displays the MOs Publish indicator.
Indicator

MOS publish default When selected: select the MOS Publish parameters by
default.

Is Program Class set When selected: sets the Program Class even if the "Read-
when checking MOS only Edit ID" option has been selected.
published read-only?

Browser
Clip Prefix Prefix for each new clip created in the storyboard.
%MEDIALABEL = Name of the original media.
Edit Prefix Prefix for each new clip inserted in the storyboard.
%EDITLABEL = Name of the original edit.
Cefiltermgr
Allow Change Media When selected: allows the user to change the media
Properties properties in Media Manager.
Max Date Interval Field to define the maximum date interval, in days, which

can be used when a search filter is applied on a date
parameter (0 = no limit).
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Max Result Set Size

Recent Date List

Field to define the maximum number of items which will be
displayed in the result list after a search filter has been
applied (0 = no limit).

Free text field to define the dates to be displayed in "recent
dates" drop-down lists.

Player

Auto Clip IN Amount of fields before the entry point of a clip when using
the auto-clipping tool (Alt+Space bar).

Auto Clip OUT Amount of fields after the out point of a clip when using the
auto-clipping tool (Alt+Space bar).

Jog Range HI Field to enter the jog range in hi-res.

Jog Range LO
PrevNextX

Shift Speed Max
Speed Max
XT Clip Creation Time

Tolerance

XT Stream Creation
Time Tolerance

Field to enter the jog range in lo-res.

Field to enter the number of fields to jump when Alt key is
used with Prev and Next buttons.

Field to enter the speed rate for super fast forward and
rewind tools when used together with the Shift key.

Field to enter the speed rate for fast forward and fast rewind
tools.

Field to enter the tolerance value (in seconds) towards the
creation time between two sibling XT clips.

Field to enter the tolerance value (in seconds) towards the
creation time between two sibling XT streams.

Storyboard

Allow Edits in
MOS Brw

Allow Export to Avid
Allow Export to File
Allow Export to Playlist
Allow Export to Target

Allow Text Insertion

Output All Stereo to
ST1

Allows drag-and-drop operations of edits.

When selected, allows to export the storyboard to Avid.
When selected, allows to export the storyboard as a file.
When selected, allows to export the storyboard to a playlist.

When selected, allows to export the storyboard to a
predefined target.

Allows to insert text.

Only applicable for “all stereo” edits, not for 5.1.
When selected: all stereo tracks are mixed out to ST1.
Otherwise: ST1to ST1, ST2to ST2, ST3t0 ST3,...
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9.2.13. How to Edit a Parameter Profile

To edit the parameters values of a profile, proceed as follows:

1. Inthe Application Selection area, select <GENERAL> or the application in which a
parameter profile should be edited.

2. Select the profile in the Profile Selection area.
In the Parameters area, edit the parameter in the Variant Values column
o by selecting or clearing the box corresponding to a parameter (check box)
o by adding the required value (field to enter a value)
o by selecting the required value (option list)

o by defining it in a specific window for a name format string (see section "How to
Modify a Name Format String" on page 99)

o for the audio parameters, see section "How to Define New Default Audio Channel
Assignment" on page 101.

The default values can be changed by editing the <default> profile.

4. Click the Save button to save the selected profile.

Note
The modifications from the <default> profile are highlighted in the Parameters

area.

9.2.14. How to Modify a Name Format String

To modify a name format string, proceed as follows:
1. Inthe Parameters area, double-click the parameter in the Variant Value column.

The [Item] Auto Name window opens:

Clip Auto Hame...

YMEDIALABEL _%aNEARFMOMTHY DAY S HOLR LM SEL

Append

Cancel
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In the first (name) field, delete the part of the string you do not want to keep in the
name, if any.

To add a generic text (i.e.: WC2006_Match03...) in the name string, simply type the
text in the field.

To add an information type specified in the Available Items list, click the arrow next
to the field and select the item in the drop-down list, for example:

TZOUTFRAME

CLIFTYPE

Click the Append button to add the selected item at the end of the Name string.

Reposition the available item as desired with the cut (CTRL-X) and paste (CTRL-V)
commands.

Repeat step 4 to 6 for any new information type you want to add in the name string.

You can reset the default name by clicking the Reset button.
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9.2.15. How to Define New Default Audio Channel
Assignment

To define a new default audio channels assignment, proceed as follows:
1. Right-click the Variant Value field.
2. Select one of the options from the contextual menu:

o Source Defined: when this option is selected, the audio track assignment from
the source media will be used.

The procedure is finished.

o Custom: this opens the Audio Track Assignments window from which you can
select the required number of channels and assign channels to tracks.

You will be able to define configurations with:
- up to 8 stereo pairs

- up to 5 stereo pairs and one 5.1 group

- up to 2 stereo pairs and two 5.1 groups.
Proceed with step 3.

The Audio Track Assignments window can also be displayed by double-clicking the
Variant Value field.
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3. From the Physical Channels list, select the required number of channels.

As many blocks as audio channels selected are displayed in the window.
4. Right-click an audio channel field.

The following contextual menu appears:

Add Group  #

5. Select one of the options:

o Mono: one audio channel is used.

1 mano il
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9.2.16.

o Stereo: two audio channels are used

o

6. Repeat the 2 last steps for the remaining channels.

How to Change the Order of Channels
inside a Track

If required, you can re-assign the order of the channels inside a group.
To do so, proceed as follows:
1. Right-click an audio channel box.

One of the following contextual menus appears:

o Mono:

Moo il . i

In this case, there is no other choice.

o Stereo:
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9.2.17.

9.2.18.

2. Select one of the options.

Consequently, two channels will have the same name within a group. So the group

name is displayed in red.

You will not be able to save the changes until this is solved.

How to Remove a Track Assignment

To cancel the assignment of a track, proceed as follows:
1. Right-click the audio track block.

A contextual menu is displayed.
2. Select Remove Group.

The corresponding blocks are empty and available again.

How to Change the Order of Tracks
Assignment

If required, you can modify order of the channels between them.
To do so, proceed as follows:
1. Right-click an audio track block.

A contextual menu is displayed.

2. Select Move Group Down to move the track after the next one, or Move Group Up

to move the track before the previous one.
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9.3.

9.3.1.

9.3.2.

Keyboard Profiles

Introduction

When you click the Keyboard Profiles button, the Softwares Keyboard Profiles window
is displayed in the Work area.

The window is divided into three areas.

yer Timeline  Playout

Default Keyboard Function(s) Variant Keyboard Function(s)

Part Name Description

1 Application This area displays the applications icons for which it is possible
Selection to manage keyboard shortcuts and keyboard profiles.
area

2 Profile This area displays the available profiles that can be managed for
Selection the selected application.
area

3 Keyboard This area gives the list of keyboard shortcuts. They can be edited
Shortcuts and modified there.
area

The keyboard profiles editor manages the key assignments for the software applications
within the Xedio suite.

Possible Actions with Contextual Menu

A contextual menu is available when an application is selected in the Application
Selection area and you right-click in the Profile Selection Area. See section "Possible
Actions with Contextual Menu" on page 73 for a description of the various options.
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9.3.3. How to Edit a Keyboard Shortcut

To edit a keyboard shortcut, proceed as follows:

1.
2.
3.

Select the application for which you want to edit the keyboard shortcut.
Select the profile to be edited.

Double click on an existing shortcut definition in the Variant Keyboard Functions
column.

The Key Assignator dialog box opens.
Enter the new shortcut in field. It can be a combination with SHIFT/ALT/CTRL, etc.
Click the OK button.

Click the Save button at the bottom of the window to save the selected profile.

Note
The <Default> profile can also be edited.

9.3.4. List of Xedio CleanEdit Keyboard Keys
Assignments

The CleanEdit keyboard profile gives access to the following lists of parameters (tabs).

General
Player Focus Sets focus on player window
Player Full Screen Zoom player window to full screen
Recorder Focus Sets focus on recorder window

Recorder Full Screen Zoom recorder window to full screen

Redo Redoes last operation

Undo (a) Undoes last operation

Undo (b) Undoes last operation (secondary shortcut)
Browser

Delete Deletes selected item

Duplicate Current Edit | Creates a duplicate of selected edit

Insert Creates a new project/edit
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Player
Auto Aspect Ratio Automatically applies the default aspect ratio.
Auto Clip Creates a quick clip with properties set in the profile.
Drop IN Drops the clip, defined in the player, after the timeline Mark
IN point.
Drop IN/IN Drops the clip, from the Mark IN point defined in the player,

Drop IN/Nowline

Drop Nowline

Drop OUT

Drop OUT/Nowline

Drop OUT/OUT

Audio1 monitoring (a)
until
Audio16 monitoring (a)

Toggle Audio1
Selection (a)
until

Toggle Audio16
Selection (a)

Toggle Video (a)

Fast Forward

after the timeline Mark IN point and towards the timeline
Mark OUT point (3-point edit).

If the clip duration is longer than the duration between the
timeline marks, the clip drop stops at the timeline Mark OUT
point.

Drops the clip, from the Mark IN point defined in the player,
after the timeline nowline and towards the timeline Mark
OUT point (3-point edit).

If the clip duration is longer than the duration between the
nowline and the timeline Mark OUT point, the clip drop
stops at the timeline Mark OUT point.

Drops the clip, defined in the player, after the timeline
nowline.

Drops the clip, defined in the player, before the timeline
Mark OUT point.

Drops the clip, from the Mark OUT point defined in the
player, before the timeline nowline and towards the timeline
IN point (3-point edit).

If the clip duration is longer than the duration between the
nowline and the timeline Mark IN point, the clip drop stops
at the timeline Mark IN point.

Drops the clip, from the Mark OUT point defined in the
player, before the timeline Mark OUT point and towards the
timeline Mark IN point (3-point edit).

If the clip duration is longer than the duration between the
timeline marks, the clip drop stops at the timeline Mark IN
point.

Toggle monitoring of the player audio stereo 1 (until audio
stereo 16).

Toggle selection of the player audio stereo 1 (until audio
stereo 16).

Toggle the selection of the player video track.

Goes fast forward the media in player window (if focus is
set to player).
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Fast Rewind

Fit to Fill IN/IN

Fit to Fill OUT/OUT

Go to End

Go to IN

Go to OUT

Go to Start

Grab Still Frame

Insert Cue Point

Mark IN (a)
Mark IN (b)

Mark OUT (a)
Mark OUT (b)

Next Frame (a)
Next Frame (b)
Next Cue Point

Next Ganged Camera
Next x Frames (a)

Next x Frames (b)

Play / Stop

Play Clip

Play Clip (Loop)
Play Forward
Play Reverse
Play Nearlive

Previous Frame (a)

Fast rewinds the media in player window (if focus is set to

player).

Drops the clip, between the IN and OUT points defined in
the player, after the timeline IN point and until the timeline

OUT point.

Drops the clip, betwwen the IN and OUT points defined in
the player, before the timeline OUT point and until the

timeline IN point.

Jumps to the end of the clip or media.
Jumps to the IN point.

Jumps to the OUT point.

Jumps to the beginning of the clip or media.

Grabs a still of the current frame.

Inserts a cue point (needs a number to be typed + "enter" for

a timeline cue point).

Sets clip IN point to current nowline position.

Sets clip IN point to current nowline position (secondary

shortcut).

Sets clip OUT point to current nowline position.

Sets clip OUT point to current nowline position (secondary

shortcut).
Goes to next frame

Goes to next frame (secondary shortcut)

Goes to next cue point in Player. Goes to next transition in

timeline

Goes to the next ganged camera

Jumps to next x frames (x is defined in the software profile)

Jumps to next x frames (x is defined in the software profile)

(secondary shortcut)

Starts/stops loaded media in the Player window from the

current position

Plays the clip to OUT point once
Plays the clip to OUT in loop mode
Plays forward at various speeds
Plays reverse at various speeds
Near live plays a recording media

Jumps to previous frame
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Previous Frame (b)

Previous Cue Point

Previous Ganged
Camera

Previous x Frames (a)

Previous x Frames (b)

Toggle All Audio
Forward 25%
Forward 33%
Forward 50%
Forward 100%
Forward 150%
Forward 200%
Forward 400%
Rewind 25%
Rewind 33%
Rewind 50%
Rewind 100%
Rewind 150%
Rewind 200%
Rewind 400%
Stop

Change Aspect Ratio

Jumps to previous frame (secondary shortcut)

Goes to previous cue point in Player. Goes to previous
transition in timeline

Goes to the previous ganged camera

Jumps to previous x frames (x is defined in the software
profile)

Jumps to previous x frames (x is defined in the software
profile)

Toggle all player audio

Goes forward at 25% speed
Goes forward at 33% speed
Goes forward at 50% speed
Goes forward at 100% speed
Goes forward at 150% speed
Goes forward at 200% speed
Goes forward at 400% speed
Rewinds at 25% speed
Rewinds at 33% speed
Rewinds at 50% speed
Rewinds at 100% speed
Rewinds at 150% speed
Rewinds at 200% speed
Rewinds at 400% speed
Stops playing the media

Changes the aspect ratio.

Playout

Goto IN Jumps to the IN point

Next Frame Jumps to next frame
Play/Stop Starts/stops to play the media

Previous Frame
Forward 25%
Forward 33%
Forward 50%

Jumps to previous frame
Goes forward at 25% speed
Goes forward at 33% speed

Goes forward at 50% speed
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Forward 100% Goes forward at 100% speed
Forward 150% Goes forward at 150% speed
Forward 200% Goes forward at 200% speed
Forward 400% Goes forward at 400% speed
Rewind 25% Rewinds at 25% speed
Rewind 33% Rewinds at 33% speed
Rewind 50% Rewinds at 50% speed
Rewind 100% Rewinds at 100% speed
Rewind 150% Rewinds at 150% speed
Rewind 200% Rewinds at 200% speed
Rewind 400% Rewinds at 400% speed
Stop Stops the recorder

Toggle Stop Warning Selects or clears the Stop Warning option in the Playout
tab. This option displays a warming message when the Stop
button is clicked.

Recorder

Auto Aspect Ratio Automatically applies the default aspect ratio

Audio1 monitoring (a) | Toggle monitoring of the player audio stereo 1
until (until audio stereo 16).
Audio16 monitoring (a)

Goto End Jumps to the end of the edit
Goto Next Transition Jumps to next transition (in regard to the selected tracks)

Goto Next Transition (b) Jumps to next transition (in regard to the selected tracks)
(secondary shortcut)

Goto Previous Jumps to previous transition (in regard to the selected
Transition tracks)

Goto Previous Jumps to previous transition (in regard to the selected
Transition (b) tracks) (secondary shortcut)

Goto Start Jumps to the beginning of the edit

Next Frame (a) Jumps to next frame

Next Frame (b) Jumps to next frame (secondary shortcut)

Next X Frames (a) Jumps to next x frames (x is defined in the software profile)
Next X Frames (b) Jumps to next x frames (x is defined in the software profile)

(secondary shortcut)

Play/Stop Starts/stops loaded edit in recorder window
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Play Forward

Play from Next
Transition

Preview Previous
Transition

Play Reverse

Preload

Previous Frame (a)
Previous Frame (b)

Previous X Frames (a)

Previous X Frames (b)

Apply Roll Changes

Roll Transition
Roll Transition bwd

Roll Transition (Rec)
Roll Transition bwd
(Rec)

Cancel Roll Changes

Roll IN

Roll IN bwd

Match Frame

Match XT Train

Roll OUT

Roll OUT bwd
Roll Clip

Roll Clip bwd
Roll Clip (Rec)

Plays forward at various speeds

Plays from next transition (in regard to the selected tracks)
(with Preroll)

Previews previous transition (in regard to the selected
tracks) (with Preroll)

Plays reverse at various speeds

Preloads the current edit in the recorder window, as well as
effect defined at this point

Jumps to previous frame
Jumps to previous frame (secondary shortcut)

Jumps to previous x frames (x is defined in the software
profile)

Jumps to previous x frames (x is defined in the software
profile) (secondary shortcut)

Applies the changes made with the roller tools in the
timeline

Combines Roll OUT and Roll IN backward
Combines Roll OUT backward and Roll IN

Performs a Roll transition while monitoring the audio from
right clip.

Performs a Roll transition while monitoring the audio from
right clip.

Cancels the changes made with the roller tools

Adds one frame (from original media) before IN point of right
clip.

Removes one frame at the beginning of right clip.

Loads the current file and picture in the player window from
its original media

Loads, in the Player, the EVS Server record train that
contains the image displayed in the Recorder.

Adds one frame (from original media) after OUT point of left
clip.

Removes one frame at the end of left clip.

Adds one frame at the beginning and remove one frame at
the end of a selected clip

Moves clip (IN and OUT points) inside the original media.

Performs a Roall clip while monitoring the right (end) part of
it.
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Roll Clip bwd (Rec)

Forward 25%
Forward 33%
Forward 50%
Forward 100%
Forward 150%
Forward 200%
Forward 400%
Rewind 25%
Rewind 33%
Rewind 50%
Rewind 100%
Rewind 150%
Rewind 200%
Rewind 400%
Stop

Change Aspect Ratio

Performs a Roall clip while monitoring the right (end) part of
it.

Goes forward at 25% speed
Goes forward at 33% speed
Goes forward at 50% speed
Goes forward at 100% speed
Goes forward at 150% speed
Goes forward at 200% speed
Goes forward at 400% speed
Rewinds at 25% speed
Rewinds at 33% speed
Rewinds at 50% speed
Rewinds at 100% speed
Rewinds at 150% speed
Rewinds at 200% speed
Rewinds at 400% speed
Stops playing the edit.

Changes the aspect ratio.

Thumbnail View (for Devices Tab)

Next Line Clip
End

Home

Next Clip
Previous Clip
Select All Clips

Previous Line Clip

Jumps to the next line clip
Jumps to the end of clip
Jumps to

Jumps to next clip

Jumps to previous clip
Select all the clips

Jumps to the previous line clip

Timeline

AddTag

Call Audio Clip FX
dialog

Call Audio Transition
FX dialog

Adds a tag to the timeline

Calls audio clip effects dialog box

Calls audio transition effects dialog box
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Blank Clear

Move Clips + 1 frame
left

Move Clips + X frame
left

Move Clips + 1 frame
right

Move Clips + X frame
right

Copy
Cut
Delete (AV lift)

Delete Clip(s)

Delete and Shift (AV
extract)

Fit to Content

Goto IN
Goto OUT

In / Out Delete (with
Cut)

Mark IN (a)
Mark IN (b)

Mark OUT (a)
Mark OUT (b)

MarkSelection

Next Ganged Camera

Paste

Shifts all timeline clips, that are situated after the nowline,
to left, removing common holes, in regard to the selected
tracks

Moves selected clips one frame to the left

Moves selected clips x frame(s) to the left (x is defined in
the software profile)

Moves selected clips one frame to the right

Moves selected clips x frame(s) to the right (x is defined in
the software profile)

Copies selected clips to the clipboard
Removes selected clips

Removes selected clips from the timeline and do not shift
the following clips to the left. This behaves like the Delete &
Clear button.

Removes selected clips from the timeline. The result will
depend on whether the Delete & Clear button or the Delete
& Shift button is activated in the timeline.

Removes selected clips from the timeline and shift the
following clips to the left. This behaves like the Delete &
Shift button.

Adjusts the timeline zooming to make the whole timeline
visible on screen.

Sets the nowline to the timeline IN point
Sets the nowline to the timeline OUT point

Removes the timeline content between the IN and OUT
points in regard to the selected tracks

Places IN point to the current nowline position

Places IN point to the current nowline position (secondary
shortcut)

Places OUT point to current nowline position

Places OUT point to current nowline position (secondary
shortcut)

Sets the timeline IN point to the beginning of the first clip
and the OUT point to the end of the last selected clip.

Replaces the selected clip by the corresponding clip from
the next ganged camera

Pastes clipboard content to the timeline, after nowline
position
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Previous Ganged
Camera

Remove IN
Remove In / Out
Remove OUT
Select All Clips

Select All Clips After
Nowline

Select All Clips Before
Nowline

Split

Toggle All Audio
Toggle Audio1 (a)
Toggle Audio2 (a)
Toggle Audio3 (a)
Toggle Audio4 (a)
Toggle Audio5 (a)

Toggle Blank Fill
On/Off

Toggle Delete / Delete
& Shift Mode

Toggle Insert/Overwrite
mode

Toggle Video (a)

Call Video Clip FX
dialog

Call Video Transition
FX dialog

Replaces the selected clip by the corresponding clip from
the previous ganged camera

Clears timeline IN point
Clears timeline IN and OUT points
Clears timeline OUT point

Selects all timeline clips in regard to the selected tracks and
to the timeline IN and OUT points

Selects all clips below and after the current nowline position
in regard to the selected tracks

Selects all clips below and before the current nowline
position in regard to the selected tracks

Cuts the clips below the nowline in two pieces in regard to
the selected tracks

Toggle the selection of all timeline audio tracks
Toggle the selection of the stereo track 1
Toggle the selection of the stereo track 2
Toggle the selection of the stereo track 3
Toggle the selection of the stereo track 4
Toggle the selection of the stereo track 5

Toggle Blank Fill mode (on/off)

Toggle Delete and Delete & Shift modes

Toggle Insert and Overwrite modes

Toggle the selection of the video track

Calls video clip effects dialog box

Calls video transition effects dialog box

Voiceover
Mark IN Sets a marker for the start of voice over
Mark OUT Sets a marker for the end of voice over

Play from IN of last VO

Play from OUT of last
VO

Plays from the beginning of the last voice over record (with
Preroll)

Plays from the end of the last voice over record (with
Preroll)
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Start Record Starts the recording of voice over
Stop Record Stops the recording of voice over
9.3.5. List of Xedio Playout Organizer Keyboard

Keys Assignments

The Xedio Playout Organizer keyboard profile gives access to the following list of

parameters.

General
Cue Cues the media
Next Skips the playout of the media and plays the next one
Pause Pauses the playout.
Play Plays the media
Prev Skips the playout of the media and plays the previous one
Stop Stops the playout of media
ToggleLoop Toggles the play mode between loop and normal
ToggleRes Toggles resolution between lo-res and hi-res within the

Playlist pane of the Playout Organizer

9.3.6. List of Xedio Browse and Xedio Browse (VC)
Keyboard Keys Assignments

The Xedio Browse and the Xedio Browse (VC) keyboard profiles gives access to the
following lists of parameters.

Player

FastFwd Goes fast forward

FastRew Fast rewinds

Goto End Jumps to last picture

Goto IN Goes to IN point

Goto OUT Goes to OUT point

Goto Start Jumps to first picture

Next Jumps to next frame

NextX Jumps to next x (preset) frames
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Play Plays/Stops loaded media in Player window from current
position

Play RTE Near-live plays a recording media/clip

Prev Jumps to previous frame

PrevX Jumps to previous x (preset) frames

Stop Stops the player
Properties

Del Marks Removes IN and OUT points

Mark IN Sets IN point of new virtual media/clip

Mark OUT Sets OUT point of new virtual media/clip

Save Saves virtual media/clip in database

SB Mark Sets new virtual media/clip IN point (the first time the key is

pressed) and OUT point (the second time the key is
pressed)

List of Xedio Cutter Keyboard Keys

Assignments

The Xedio Cutter keyboard profile gives access to the following lists of parameters.

General

Player Focus
Player Full Screen
Recorder Focus

Recorder Full Screen

Sets the focus on player
Sets the player to full screen
Sets the focus on recorder

Sets the recorder to full screen

Redo Redoes the last action

Undo (a) Undoes the last action

Undo (b) Undoes the last action (secondary shortcut)
Player

Auto Clip Sets clip IN and OUT points on the fly

Toggle Audio1 (a)
Toggle Audio1 (b)
Toggle Audio2 (a)

Toggle the audio stereo 1 of the player
Toggle the audio stereo 1 of the player (secondary shortcut)

Toggle the audio stereo 2 of the player

116

9. Softwares



USER MANUAL Xedio Suite 4.40 Xedio Manager

=V

Toggle Audio2 (b)
Toggle Audio3 (a)
Toggle Audio3 (b)
Toggle Audio4 (a)
Toggle Audio4 (b)
Toggle Video (a)
Toggle Video (b)
Fast Forward

Fast Rewind

Goto End

Goto IN

Goto OUT

Goto Start

Insert Cue Point
Mark IN (a)

Mark IN (b)

Mark OUT (a)
Mark OUT (b)
Next Frame (a)
Next Frame (b)
Next Cue Point
Next x Frames (a)
Next x Frames (b)

Play/Stop

Play Clip

Play Clip Loop
Play Forward
Play Reverse

Play NearLive

Previous Frame (a)
Previous Frame (b)
Previous Cue Point

Previous x Frames (a)

Toggle the audio stereo 2 of the player (secondary shortcut)
Toggle the audio stereo 3 of the player

Toggle the audio stereo 3 of the player (secondary shortcut)
Toggle the audio stereo 4 of the player

Toggle the audio stereo 4 of the player (secondary shortcut)
Toggle player video

Toggle player video

Fast forward the media

Fast rewind the media

Jumps to end of clip or media

Goes to clip IN point

Goes to clip OUT point

Jumps to start of clip or media

Inserts a cue point

Sets clip IN point

Sets clip IN point (secondary shortcut)

Sets clip OUT point

Sets clip OUT point (secondary shortcut)

Jumps to next frame

Jumps to next frame (secondary shortcut)

Goes to next cue point

Jumps to next x (preset) frames

Jumps to next x (preset) frames (secondary shortcut)

Plays/Stops loaded media in Player window from current
position

Plays the clip from IN to OUT once

Plays the clip from IN to OUT in loop mode
Plays forward at various speeds

Plays reverse at various speeds

Plays near-live a recording media

Jumps to previous frame

Jumps to previous frame (secondary shortcut)
Goes to previous cue point

Jumps to previous x (preset) frames
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Previous x Frames (b)
Forward 25%
Forward 33%
Forward 50%
Forward 100%
Forward 150%
Forward 200%
Forward 400%
Rewind 25%
Rewind 33%
Rewind 50%
Rewind 100%
Rewind 150%

Jumps to previous x (preset) frames (secondary shortcut)

Goes forward at 25% speed
Goes forward at 33% speed
Goes forward at 50% speed
Goes forward at 100% speed
Goes forward at 150% speed
Goes forward at 200% speed
Goes forward at 400% speed
Rewinds at 25% speed
Rewinds at 33% speed
Rewinds at 50% speed
Rewinds at 100% speed
Rewinds at 150% speed

Rewind 200% Rewinds at 200% speed
Rewind 400% Rewinds at 400% speed
Stop Stops the player
Storyboard
Delete Deletes the selected line(s)
Move Down Moves the selected line(s) down
Move End Moves the selected line(s) to the end of the list
Move Top Moves the selected line(s) to the top of the list
Move Up Moves the selected line(s) up

Keyboard Machines

Introduction

The profiles that are created for keyboard assignments can be assigned to workstations
through their IP address by the Keyboard Machines tool.

When you click the Keyboard Machines button, the Softwares Keyboard Machines
window is displayed in the Work area. It is divided into three areas:

1. Application Selection area

2. Profile Selection Area

3. List of machines
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9.4.2.

9.5.

Fevboard profiles :

1.1.70.11

Possible Actions with Contextual Menu

A contextual menu is available when an application is selected in the Application
Selection area and a keyboard profile is selected in the Profile Selection Area and then
you right-click in the Parameters area:

Menu Item Description

Add Allows to assign a keyboard profile to a workstation. You will have to
enter the IP address of the workstation and click the Save button.
Delete Allows to un-assign the keyboard profile to the selected workstation.
Note

The CleanEdit application may have to be restarted to apply the changes if it is
currently running on the workstation.

Video FX

Introduction

The Video FX tool sets the name and default parameters for the transition, clip and
conversion effects.

When you click the Video FX button, the Video FX window is displayed in the Work area.

9. Softwares

119



EVS Broadcast Equipment SA Issue 4.40.A - November 2013

Editing Default Parameters for Effects

To modify the default parameters for transition, clip or conversion effects, double-click the
effect name in the list, enter or select new values in the relevant fields, and click the OK

button.
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10.

10.1.

Tools

Introduction

From the Tools category, you can manage projects, clips, edits, playlists and broadcasted
items, and you can define classes.

Nine items are available in the Tools category. They are detailed in the table below.

Item Description

Program Class Manager Allows to define classes to categorize the edits.

Projects Manager Allows to manage the list of projects.

Clips Manager Allows to manage the list of clips.

Edits Manager Allows to manage the list of edits.

Playlists Manager Allows to manage the list of playlists.

Broadcasted Items Allows to manage the list of items already broadcasted.

Manager

Tag Manager Allows to define templates and pages for external CG
integration.

Script Manager Allows to activate scripts performing some pre-defined
actions.

Monitoring Gives an overview of the database content and the disks
capacity.
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10.2.

10.2.1.

Program Class Manager

Introduction

This tool is used to define and manage the classes structure of the database. It allows the
classification of the edits and tells the system that the edit has been made for a particular
production.

When you click the Program Class Manager button, the Program Class Manager
window is displayed in the Work area.

- & News Report

Al

10.2.2.

Possible Actions with Contextual Menus

A contextual menu is available when no class is selected and you right-click in the
Program Class Manager window.

Menu Item Description

New Root Creates a new class of program.

A contextual menu is available when you select a class in the list and then right-click:

Menu Item Description

New Root Creates a new class of program.

New Child Creates a new sub-class of program.

Rename Allows to rename the selected class or sub-class.

Modify Opens the Modify Class window allowing to update the label or

description of the selected class or sub-class.
Delete Deletes the selected class or sub-class.

Hidden State @ Hides/Unhides the selected class or sub-class so users cannot/can
use it.

122

10. Tools



USER MANUAL Xedio Suite 4.40 Xedio Manager — / —.

10.3.

10.3.1.

10.3.2.

Projects / Clips / Edits / Playlists
Manager

Introduction

The Projects, Clips, Edits and Playlists Manager tools are designed to show an overview
of the database content. They make it possible to edit properties and remove undesired
items from the database. Edits may also be recovered after deletion by a user.

When you click the Projects Manager, Clips Manager, Edits Manager or Playlists
Manager button, the corresponding Manager window is displayed in the Work area.

Each of these manager tools has a similar interface with 2 areas.

The upper part of the Work area shows a list of icons. These buttons give access to the
different filters to be applied to the media list.

The element grid displays the content present in the database, or it returns the result of a
search applied to the list.. Items are displayed in columns.

Element Grid

Displayed Columns

It is possible to re-arrange the columns order, and to add or remove some columns.

Right-clicking on any of the column headings displays a contextual menu. The Choose
Displayed Columns option opens the Select Visible Columns window allowing you to
choose the columns you want to be displayed in the element grid.

The column width and order can be adjusted using standard computer commands and
drag and drop techniques.
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Element Contextual Menu

A contextual menu is available when you right-click on an item in the list. The options may
differ according to the tab selected.

Projects Manager

;_%

=

E User Description Creation D ate lodification Date | YideoStandard Deleted

2 1 Support evs [evs] 2-03-2009 16:45:54 12-03-2009 16:45:54 PAL 5D 7
2 Support evs [evs]l  Project created by £24-09-2009 135714 14-09-2003 135714 HD 1080 (250 7
3 Support evs [evs]  Project created by £24-09-2009 13:55:16 14-09-2003 135316 HD 1080i (250 7
4 Support evs [evs]  Project created by £24-09-2009 14:00:11 *4-09-2009 14:00:17  HD 1080i &50 7
5 Support evs [evs]  Project created by £24-09-2009 14:03:38 *4-09-2009 14:03:38  PAL 5D 7
E Support evs [evs]  Project created by e24-09-2009 14:05:18 24-09-2009 14:05:18  PAL 5D 7
7 Delbruyere Arne [ac 11-10-200914:18:04 1-10-2009 14:18:04  HD 1080i @50 1
& Georges Pascale [p JE-10-200911:13:39 51120010 16:3%.55 PAL SD 12

Project Menu Item  Description

Hidden State Allows to change the “hide” status.
Deleted State Allows to change the “delete” status.
Delete Projects Allows the deletion of the selected projects. This will

automatically delete the edits and clips contained in the project.

Properties Displays the Project Properties window and allows to change the
project properties.

Used by... Opens a window to show where the project is used.

Clips Manager

Label Clip TCIN Clip Duration

fepo) | AU

Clip TC OUT | Description Creation Date | Thumbnail In Thumbnail Out |Last Modif. Date Tsln

Athletisrne C00030_ 01:68:1211 00:00:11:03 01:59:23:14 510-2009 141257 5-10-2009 141257 7162 440000

Athletisrne C00030_ 01:68:23:15 00:00:08:02 01:59:23:17 510-200914:1312 e 5-10-2009 14:1313 7163.600000

Athletisrne C00030_ 01:68:2518 00:00:05:23 01:59:35:16 510-200914:13:14 -

Athletisrne C00030_ 01:68:35:17 00:00:05:04 01:55:40:21 510-200914:1317

E-10-2009 11:42:54 7169.720000

5-10-2009 14:1318 7176680000

11:63.5716 00:00:10002 11:54:07:24 310-2009 13:46:28 M Eid '3-10-2009 13:46:29 42837 640000
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Clip Menu Item

Description

Properties
Delete Clip(s) &

Purge

Force Delete

Create Missing
Thumbnails

Used by...

Displays the Clip Properties window and allows to change the clip
properties.

See section "Delete & Purge" on page 127.

Deletes a clip with all the references of its use in the database. If it
is used in an edit, this will cause “holes” in the edit.
This option must be used very cautiously.

Creates thumbnails IN and OUT. Thumbnails are displayed
provided that the Thumb IN and Thumb OUT columns are made
visible.

Opens a window to show in which projects and edits the selected
clipis usedin.

Edits Manager

je

%)

=
=5
3
=
-
]
g
<

] ot Edit_0m1

5 k00 48

Delbiupere &nne [ac Mews Repart, Last E 00:00:28:12 Edit_DO1 11-10-2009 14:22:17 23-10-2009 133717 1673
Georges Pascale [p Mews Repart 00:01:04:10 Edit_007 J6-10-2009 14:53:34 16-10-2009 15:51:10 JE-10-2009 15:51:10 4/3
Georges Pascale [p Mews Repart 00:00:55:21 Edit_001 Duplicatec E-10-2009 14:43:17 5-11-2010 14:04:04 4/3
Georges Pascale [pr Mews Report 00:01:04:10 Edit_001 Duplicatec E-10-2009 14:53:23 B-10-2009 14:53:23 4/3
Delbiupere Anne [ac Highlights. Short 00:00:26:02 Rugby_Edit_1 23-10-2009 13:44:39 28-10-2009 11:11:05 1673
Support evs [evs]  Mews Report 00:00:12:13 Concert 1 28-10-2009 09:06:18 28-10-2009 09:42:29 1673
Delbiupere Snne [ac Mews Repart 00:00:12:13 Concert 1 28-10-2003 11:10:50 28-10-2009 11:117:41 1673
Delbiupere Snne [ac Mews Report 00:16:11:04 Concert 1 28-10-2009 11:12:02 28-10-2009 12:43:25 16/3
Edit Menu Item Description

Deleted State

Delete Edit(s) &
Purge

Force Delete

Export Edit(s)

Import Edit(s)

Allows to change the “delete” status.

See section "Delete & Purge" on page 127.

Deletes an edit with all the references of its use in the database, as
well as the media contained in the edit.
This option must be used very cautiously.

Allows the edit to be exported

* intoafolderor

* into another CleanEdit database. You will then have to mention
the Database Source Name.

Allows to import an edit: in the Import window, right-click the
Folder(s) field and select Add Folder(s).
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Playlist1
Playlist1
Playlist1
Playlist1
Plavlist_pge 001
Plavlist_pge 002

Plavlist1

Edit Menu Item

Description

Play

Show Used File
(s)

Convert Ratio

Properties

Duplicate Edit

Generate PLST
File

Used By...

Opens a player window in which the selected edit can be viewed in
low or high bitrate.

Shows the list of files used by the edit.

Allows to change the video ratio.

Displays the Edit Properties window and allows to change the edit
properties. If a default metadata profile has been defined for edits, a
metadata tab is displayed and allows to modify the edit metadata
values.

Creates an edit with the same properties. The term "duplicated" is
added next to the new edit.

Generates a text file which represents the edit and which can be
dropped on the playout.

Opens a window to show in which projects and playlists the
selected edit is used in.

Georges Pascale (p
Georges Pascale [
Delbruyere Anne (a0
Georges Pascale [
Georges Pascale [

Georges Pascale [

Playlists Manager

Search
Deleted m

00:06:02:01 J6-10-2003 15: 3553 16-10-2009 15:37:29 JE-10-2009 15:35:53 ¥

00:00:20:22 30-10-2003 16:24:08 310-10-2009 16:24:51 30-10-2009 16:24:08
00:00:00:00 25-11-2003 11:16:36 17-10-2011 12:20:21 '5-11-2009 11:16:36
00:00:55:05 26-11-2003 16:40:33 20-01-2010 12:02:23 '6-11-2009 15:40:33
00:00:35:05 26-11-2003 16:40:58 11-12-2009 11:00:26 '6-11-2009 16:40:58

05:45:07:22 7-11-2003 08:42:25 17-10-201011:19:01 17-11-2009 D8:42:25

Playlists Menu
Item

Description

Deleted State
Delete Playlist(s)
Show Used Files

Properties

Allows to change the “delete” status.
Allows the selected playlist(s) to be deleted.
Shows the list of files used in the playlist.

Displays the Playlist Properties window and allows to change
the playlist properties.
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10.3.3.

10.3.4.

10.4.

Item Label

Searching the Database

The Xedio Suite offers several ways to filter the database. They are described in section
"Searching for Elements in the List" on page 47.

Filters you have defined can be saved to be applied later on in one click. Saved Filters
options are described in that section as well.

Delete & Purge

The Delete Edit(s) & Purge and Delete Clip(s) & Purge functions allow the user to
remove unused edits and clips from the media server while deleting them from the
database.

There are several options available when using this function:
1. Delete Edit/Clip database references: removes entries from the database only.

2. Delete Edit/Clip database references AND media database references: removes
entries from the database only.

3. Delete Edit/Clip database references, media database references AND linked media
files from online/nearline storage: removes entries from the database and from the
media server.

The media will be removed only if they are not used in other edits or in other playlists
(either the media itself or through attached virtual media or virtual clips).

Additionally, all associated material such as virtual media and virtual clips that are used in
the edit(s) or playlist(s) selected for deletion will be removed from the database.

See section "Media File Cleaner" on page 135 for more powerful media delete and purge
options.

Broadcasted Items Manager

The Broadcasted Items Manager gives the list of all items played out from Playout
Organizer software. The tool is designed to have an overview of the database content and
remove items that are no longer required because they have been flagged as broadcasted.

When you click the Broadcasted Items Manager button, the Broadcasted Items
Manager window is displayed in the Work area.

Edit Mode Bri
Prisg

Item Type  PlayList Label UserName Playout Server lroadcated DateTimelete Program Class
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127



EVS Broadcast Equipment SA

Issue 4.40.A- November 2013

10.5.

Script Manager

A series of scripts is available from Xedio Manager and can be activated from the Script

Manager.

When you click the Script Manager button, the Script Manager window is displayed in

the Work area.

Available scripts

Edit_lJpd_R.

Applied scripts

Edit_Upd_RTE_ToxT

The table below gives a description of the scripts you could find in the list:

Script Description

CEDB_ Archives once a day all media older than x hours
ArchiveOlderMedia

CEDB_ Purges partial media that have been created for more than
PurgePartialMedia 24 hours and that are not scheduled in the next 24 hours.
CEDB_ Allows the execution of a script for export and rendering of
RenderBroadcastedJob each edit broadcasted since more than 24 hours.

CEDB_ Inserts a restore task in EvsTaskEngine do-list for each edit
RestoreToBePlayed to be played in the next Z hours.

Edit Upd_RTB_ Exports an edit to a playlist file and reference it in an xml file.
ExportEdit

Edit_Upd_RTB_ToDB

Edit_Upd_RTB_ToXT

Renders and publishes to DB when an edit's R2B_
DateTime is updated.

Renders and publishes to EVS video server when an edit's
R2B_DateTime is updated.

To enable a script, select it in the Available scripts list and click the >> button to move it in

the Applied scripts list.
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10.6. Monitoring

When you click the Monitoring button, the Monitoring window is displayed in the Work
area. It gives an overview of the database content and the disks capacity.

Virtual Media

PlayLists
Scheduler

M ch

#STORE7ZO1L0

10. Tools 129



EVS Broadcast Equipment SA Issue 4.40.A - November 2013

11.

11.1.

11.2.

Users

Introduction

The users authorized to access the Xedio Suite are defined in Xedio Manager, under the
Users category.

Several items are available in the Users category. They are detailed in the table below.

Item Description

User Role Manager Manages the user roles.

User Manager Manages the users and access rights.
License Manager Allows software connection to database.

User Role Manager

Introduction

The management of user access rights is based on the definition of user roles and the
assignment of each user to a specific role.

When the Window authentication by Active Directory is used to log in, user roles defined
in Xedio Manager must be named as the Windows domain groups. Any user added to a
Windows group automatically inherits the user rights associated to the corresponding
Xedio user role.

When you click the User > User Role Manager button, the User Role Manager window
is displayed in the Work area.
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Software User Level Parameter Profile

Contextual Menu

A contextual menu is available when you right-click the Role list area. The availability of
the options will differ whether an existing role is selected or not.

The following table describes the commands from the contextual menu:

Command Description

New Used to create a new user role.

Delete Deletes the selected user role.

It is only available when a role is selected.

Duplicate Creates a new user role by duplicating the selected user role with all its

profiles settings.
It is only available when a role is selected.

How to Create a User Role

To create a new user role, proceed as follows:

1.

2
3.
4

Right-click the Role list area.
Select New from the contextual menu.
Enter a name for the new role in the Label field.

For each software listed in the Profile(s) area, click in the User Level column to
display the available user levels: no access, User, Admin.

Select one of the user levels.

11.Users
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11.3.

6. Click in the Parameter Profile column.

The list of parameter profiles which have been set from Softwares > Parameter
Profiles for the corresponding Xedio software is displayed. When no parameter profile
has been defined for an application, the default profile is used.

7. Select one of the parameter profiles.
Repeat steps 6 and 7 for each software listed in the Profile(s) area.
Click Save.

User Manager

Introduction

Login and access rights have to be defined and stored into the database. Each user must
be assigned to a user role before being able to use any of the Xedio Suite software.

When the Window authentication by Active Directory is used to log in, users who would
not be defined in the User Manager will automatically be created at login and associated to
the Xedio user role corresponding to their Windows group.

When you click the Users > Manager button, the Users Manager window is displayed in
the Work area.

LUser List

B
B
B

UserRole:  |Egibar

0:23:04 AM

Both the users created from Xedio Manager and from the Active Directory are displayed.

The creation and edition of user accounts are not available to users who have logged in
with the Window authentication method.

User accounts automatically created in Xedio Manager through the Window
authentication method are read-only and remain read-only, even when the Window
authentication method is disabled.
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Contextual Menu

A contextual menu is available when you right-click the User list area. The availability of
the options will differ whether an existing user is selected or not.

The following table describes the commands from the contextual menu:

Command Description

New Used to create a new user.
Not available when the user has logged in with the Window
authentication method.

Delete Deletes the selected user.
It is only available when a user is selected.

How to Create a User

To create a new user, proceed as follows:

1. Right-click the User list area.

2. Select New from the contextual menu.

3. Complete the User Properties area

The following table describes the user properties.

Field

Description

Account Enabled
checkbox

First Name field
Last Name field
Login field

Password button

Description field

User Role menu

Last Logon

Allows to enable or disable the selected account.

First Name of the new user.
Last Name of the new user.
Login, or user ID, of the new user.

Used to create a password for the new user account or to modify
the password of an existing user account.

Optional text to describe the user.

List of user roles defined from the User Role Manager.
See section "User Role Manager" on page 130.

Read-only field showing the last time the selected user has
logged on.

4. Click Save.

The user name is added to the User list.

11.Users
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11.4. License Manager

Control Manager [P :

Apply

The License Manager IP address is read by each workstation software when an
application starts. The applications connect to this address and ask for a new available
connection (license). If allowed, the application will launch, otherwise, an error message
will be displayed and the application will not open.
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12.

Media File Cleaner

The Media File Cleaner is a tool that allows the user to retrieve and list the orphan files.
These are files that are stored on the media server but that are not referenced in the Xedio
database. These files can be viewed and deleted.

The Media File Cleaner is available from the Tools menu in Xedio Manager providing that
no tool is selected in the Outlook area.

Media Dir
0=

A filtering can be applied before starting a search for orphan files. This filtering allows the
user to perform the search on all the media servers or only on one of them and in all the
folders orin only one of them.

Once the filter is configured, the search is started using the Refresh button or the F5
keyboard shortcut.

A right-click on an orphan media opens a contextual menu that allows to Play the media or
to Delete it.

Deleting a media file means removing it definitively from the server. This operation cannot
be undone. To prevent accidental deletion, the following confirmation message is
displayed before the operation is completed:

achion will definitively era:

L want o pr
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